DIGITAL STORYTELLING COOKBOOK

January 2010

Joe Lambert

Contributions by
Amy Hill
Nina Mullen
Caleb Paull
Emily Paulos
Thenmozhi Soundararajan
Daniel Weinshenker

Digital Diner Press
© 2010 Joe Lambert, Digital Diner Press
ISBN: 978-0-9726440-1-3

This work is licensed under the Creative Commons Attribution-NonCommercial-ShareAlike 2.5 License. To view a copy of this license, visit http://creativecommons.org/licenses/by-nc-sa/2.5/ or send a letter to Creative Commons, 543 Howard Street, 5th Floor, San Francisco, California, 94105, USA.

Produced by the Center for Digital Storytelling, a non-profit arts and education organization.

Center for Digital Storytelling
1803 Martin Luther King Jr. Way
Berkeley, CA 94709 USA
www.storycenter.org
info@storycenter.org
510-548-2065 tel
510-548-1345 fax

Also Available:
Contents

Preface........................................................................................................V
1 Stories in Our Lives.............................................................................1
2 Seven Steps of Digital Storytelling..................................................9
3 Approaches to Scripting.....................................................................25
4 Storyboarding......................................................................................31
5 Digitizing Story Elements .................................................................36
6 Introduction to Photoshop Elements ...............................................44
7 Introduction to Final Cut Express ......................................................60
Our work in Digital Storytelling was inspired by the efforts of the late Dana W. Atchley. His performance *Next Exit*, and the stories he shared, continue to inspire others to honor their lives.

Find out more about Dana Atchley's work at nextexit.com.
Preface

“Stories move in circles. They don’t move in straight lines. So it helps if you listen in circles. There are stories inside stories and stories between stories, and finding your way through them is as easy as and as hard as finding your way home. And part of the finding is getting lost. And when you’re lost, you start to look around and listen.”

—Corey Fischer, Albert Greenberg, and Naomi Newman
A Travelling Jewish Theatre from Coming from a Great Distance
Excerpted from Writing for Your Life by Deena Metzger

When I worked in theater, the first show at my venue was a show by John O’Neal, the legendary founder of the Free Southern Theater.

He was doing one of his Junebug Jabbo Jones stories, recounting the events of the rural south and the civil rights movement. Ten years later to the week, John O’Neal was the last performer before I turned my theater over to new managers, performing with Naomi Newman in Crossing the Broken Bridge, a story about African-American and Jewish American relations.

These bookends of my professional theater experience say a great deal about the role story and ancient root cultures played in forming my attitude about the storytelling arts in our civic life. In the tremendous oral traditions of African and Jewish cultures, there is an assessment of storymaking and telling that is synonymous with the value of life itself. Story is learning, celebrating, healing, and remembering. Each part of the life process necessitates it. Failure to make story honor these passages threatens the consciousness of communal identity. Honoring a life event with the sacrament of story is a profound spiritual value for these cultures. It enriches the individual, emotional and cultural development, and perhaps ultimately, the more mysterious development of their soul.

The circles of stories passing through the journey of my life as a digital storytelling facilitator have brought me back to this. As we are made of water, bone, and biochemistry, we are made of stories. The students that share their stories in our circles recognize a metamorphosis of sorts, a changing, that makes them feel different about their lives, their identities.

In this cookbook, we share with you our storytelling approach. We hope you will find it inspiring as well as useful.

Our cookbook has just one recipe, Momnotmom by Thenmozhi Soundararajan. To view the completed piece, visit us on-line at www.storycenter.org.

The rest of this cookbook will break this digital story down into a recipe with ingredients, that will help you to prepare it all again. We’ll talk more about stories in general too, so you can take this recipe and adapt it to your own tastes. We encourage you to make the digital story you’re hungry for.

— Joe Lambert, Director
Center for Digital Storytelling
1 Stories in Our Lives

A story can be as short as explaining why you bought your first car or house, or as long as War and Peace. Your own desires in life, the kinds of struggles you have faced, and most importantly, the number and depth of realizations you have taken from your experience all shape your natural abilities as an effective storyteller. Translating those realizations into stories in the form of essays, memoirs, autobiographies, short stories, novels, plays, screenplays, or multimedia scripts, is mainly about time. You need time to put the raw material before you, time to learn procedures and approaches for crafting the story, and time to listen to the feedback and improve upon your efforts.

For some, conceiving an idea for a story is an easy process, while for others it is the beginning of a crisis. The issue of how we get from our conversational use of story to crafting a work that stands on its own falls more into the category of a general creative process. Why and how do we remember stories? What affects our ability to retain stories? How do we develop our own sense of voice and story? And what kinds of stories from our lives are likely to work as multimedia stories?

That Reminds Me of a Story

Cultural anthropologist Gregory Bateson was asked in the 1950s if he believed that computer-based artificial intelligence was possible. He responded that he did not know, but that he believed when you would ask a computer a yes-or-no question and it responded with “that reminds me of a story,” you would be close.

Our understanding of how story is at the core of human activity has been a subject of fascination for academics and experts in the computer age. Educational and artificial intelligence theorist Roger Schank has argued in the last decade that the road to understanding human intelligence, and thus the road to artificial intelligence construction, is built on story. In Schank’s 1992 book, Tell Me a Story, he suggests that the cyclical process of developing increasingly complex levels of stories that we apply in increasingly sophisticated ways to specific situations is one way to map the human cognitive development process. Stories are the large and small instruments of meaning and explanation that we store in our memories.

So why is it that when many of us are asked to construct a story as a formal presentation to illustrate an idea, we go blank? We informally tell stories all the time, but the conscious construction of story calls up mental blocks. Here are three possible reasons:

Overloaded Memory Bank

From the standpoint of cognitive theory, the problem is about being overwhelmed by stories that we can’t process. Our minds construct a sense of memory immediately after being part of an experience or hearing a story, and unless we have a dramatic experience, or have a particular reason to constantly recite the story of the experience, it slowly diminishes in our memory. Retrieval of a given story or experience becomes more difficult the farther away we are in time from the original story or event.
Chapter 1: Stories in Our Lives

In oral culture, we humans learned to retain stories as epigrams, or little tales that had a meaningful proverb at the end. The constant repetition of epigrammatic tales gave us a stock supply of references to put to appropriate use, like the hundreds of cowboy sayings I grew up with in Texas, to apply to a wide range of situations. In our current culture, many of us have not developed an epigrammatic learning equivalent to these processes.

At the same time, we are bombarded with millions of non-digestible and non-memorable story fragments every time we pick up a phone, bump into a friend, watch TV, listen to the radio, read a book or a newspaper, or browse the Web. We simply cannot process every one of these encounters and turn them into epigrams, let alone recite and retain them, and so they become a jumble of fragments that actually inhibit our ability to construct a coherent story.

Only people who develop effective filtering, indexing, and repackaging tools in their minds can manage to successfully and consistently articulate meaning that reconstructs a coherent story. We think of the skilled professionals in any given field as having developed this process for their specialty. They can tell appropriate stories—the memory of cases for a trial lawyer, for example-based on having systematized a portion of their memories. But most skilled professionals have difficulty using examples outside of their respective fields, from their personal life or non-professional experience, but those who do are often described as storytellers.

This is one of the arguments for the lifelong Memory Box as a retrieval/filtering/construction system to assist us in this process. Images, videos, sounds, and other representations of events from our life can help us to reconstruct more complete memories and therefore expand the repertoire of story that we can put to use.

The Editor

Having worked in arts education settings, we are experienced with people telling us that they have no story to tell. Along with language arts educators and psychologists, we are aware that most of us carry around a little voice, an editor, that tells us that what we have to say is not entertaining or substantial enough to be heard. That editor is a composite figure of everyone in our lives who has diminished our sense of creative ability, from family members, to teachers, to employers, to society as a whole. We live in a culture where expert story-making is a highly valued and rewarded craft.

Once we fall behind in developing our natural storytelling abilities to their fullest extent, it takes a much longer commitment and concentration to reclaim those abilities. As adults, time spent in these creative endeavors is generally considered frivolous and marginal by our society, and so few pursue it. Those of us who have assisted people in trying to reclaim their voice know that it requires a tremendous sensitivity to successfully bring people to a point where they trust that the stories they do tell are vital, emotionally powerful, and unique. Were it not that we as human beings have a deep intuitive sense of the power of story, it’s a wonder that we have a popular storytelling tradition at all.
The Good Consumer Habit

Our awareness of the residual impact of mass media has grown tremendously over the past thirty years. Media literacy experts have thoroughly documented that a pro-
longed exposure to mass media messages over time disintegrates our critical intel-
ligence. The process is, in part, the effect of the over-stimulation we already mentioned. Yet, beyond the fact that we are immersed in too much TV and other media forms, it is the style in which these media, particularly advertising, present themselves that actually affects our sense of ourselves as storytellers. If I can get more attention for the kind of shoes I wear or the style of my hair at one-tenth the conscious effort of explaining what the heck is wrong or right about my life in a way that moves you, why not take the simpler route instead? Status and recognition, in our consumer culture, is an off-the-rack item.

Finding Your Story

For all of these reasons and quite a few others, a person’s initial efforts at story-
making can be frustrating. We have worked with several high-powered communicators who froze up like a deer in the headlights when it came time for them to construct an emotionally-compelling personal tale.

The starting point for overcoming a creative block is to start with a small idea. It is a natural tendency to want to make a novel or screenplay out of a portion of our life experiences, and to think in terms of getting all the details. But it is exactly that kind of scale that disables our memory. Our emphasis on using photographic imagery in our digital storytelling workshops facilitates the process of taking a potential story, picture-by-picture. Pedro Meyer, in creating his breathtakingly compelling I Photograph to Remember CD-ROM, recorded a narrative by simply setting up a tape recorder in his living room. He asked his publisher, Bob Stein, to sit beside him as he recorded his voice while he described each photograph to Bob. That was it. One take and it became the voice-over that was used for the CD-ROM. This process may work for your project.

Perhaps your project does not originate with visual material on hand. Take a look at our example interview questions in the next section for various kinds of short personal stories. Have someone interview you, then transcribe the words and see what they tell you about the story you are trying to conceive.

As you are putting together your raw material for your story, you are also working to build your narrative voice. Everyone has a unique style of expressing him or herself that can jump off the page or resonate in a storytelling presentation. Realizing your voice, and making it as rich and textured as you are as a person, takes time and practice.

The process of moving from a journalistic, technical, or official voice towards a more organic and natural voice is often difficult. It is as if we are trying to merge the two different parts of our brains: the analytical and the emotive. Most of us can’t switch back and forth without getting at least slightly confused. The official voice is the voice of our expository writing class, our essays and term papers, or our formal memos and letters to our professional colleagues. We have been taught that this voice carries dispassionate authority, useful perhaps in avoiding misunderstandings, but absolutely deadly as a story.
Getting feedback also helps us identify our narrative voice. Reading material aloud to someone who we know well, and asking him or her to identify which part is true to our voice is a useful practice. Of course, crafting a narrative voice by moving away from clichés and redundancy requires pulling out the thesaurus to substitute common verbs and adjectives. But in the end, take your time and let the ideas and meanings sink in before you edit. If something feels overwhelmingly right, don't polish it too much. We have had lots of scripts that started out fresh and authentic, but by the time the authors and collaborators got through with it, it was filled with succinct and gorgeous-yet-characterless prose.

## Interviewing

The following series of question sets for the “Interview” or “Self-Interview” process can assist in the development of different kinds of stories, but it is not meant to supplant a more direct scripting process if that is how you are accustomed to working. However, almost all of us can gain from having source material that appears from a less self-conscious response to a set of directed questions.

In recording your responses, you may find that you have sufficient material to make your voice-over. Cutting and rearranging your responses using digital audio editing software may be all that is required. If you take this route, keep in mind that you must take steps to ensure a good-quality recording.

## Interviewing Techniques

You may find it easier to respond to these questions directly into a microphone in the privacy of your own home or office as opposed to a workshop space. If the prospect of talking to a recording device is off-putting (and it may be more likely to increase your self-consciousness than relax you), have someone interview you. This can be a friend, a spouse, relative, or co-worker. This process can be both fun and revealing, but requires that the interviewer commit to a few common-sense ideas.

## Guidelines for the Interviewer

1) Study the questions so that you are not reading from the page, and feel free to ad lib. Being able to sustain eye contact assists the interviewee in relaxing and responding in a natural way.

2) Allow the interviewee to complete his or her thoughts. Unlike a radio or TV interviewer that is concerned with “dead air” in the conversation, give the interviewee all the time desired to think through and restate something that is a bit difficult to articulate. Interruptions can cause people to lose their train of thought or become self-aware and steer away from important, but perhaps emotionally difficult information. Let the interviewee tell you when he or she has finished a question before moving on to the next.

3) When appropriate, use your own intuition when asking questions to get more detailed responses. Often, a person’s initial thoughts about a question only retrieves a broad outline of a memory. Feel free to request specifics or details that would clarify or expand upon a general response.
4) If the story is about information that is specifically painful or traumatic in the person's life, carefully assess how far you will allow the respondent to delve into these memories. In many situations where the interviewer is not a spouse or a loved one, you may cross into territory that is much better approached in a therapeutic environment with experienced guides or professionally trained advisors. We have come perilously close in interviews to taking people into an emotional state from which they cannot return at the session. This is embarrassing for the respondent, and an emotionally insensitive act on the part of the interviewer, as the interviewee may not have the therapeutic support to cope with these issues in the hours and days after the interview. Don't feel you need to hunt for emotionally charged material to make the interview effective. If it comes naturally and comfortably, so be it.

Finally, along with ensuring privacy in the interview, make sure everyone is comfortable: comfortable chairs, water at hand, and the microphone positioned so as not to disrupt ease of movement. (A lavaliere, or pin-on microphone, is the best).

---

**Kinds of Personal Stories**

There are all kinds of stories in our lives that we can develop into multimedia pieces. Here are a few sets of example questions for some of these stories. Adapting any of the question sets by integrating the existing sets, or developing a separate set, is encouraged.

**The Story About Someone Important**

**Character Stories**

How we love, are inspired by, want to recognize, and find meaning in our relationships are all aspects of our lives that are deeply important to us. Perhaps the majority of the stories created in our workshops are about a relationship, and in the best stories they tell us more about ourselves than the details of our own life story.

**Memorial Stories**

Honoring and remembering people who have passed is an essential part of the grieving process. These stories are often the most difficult and painful to produce, but the results can be the most powerful.

- What is, or had been, your relationship to this person?
- How would you describe this person (physical appearance, character, etc.)?
- Is there an event/incident that best captures their character?
- What about the person do/did you most enjoy?
- What about the person drives you crazy?
- What lesson did the person give to you that you feel is most important?
- If you had something to say to the person but they never had a chance to hear you say it, what would it be?
The Story About an Event in My Life

Adventure Stories

One of the reasons we travel is to break away from the normalcy of our lives and create new vivid memories. All of us who travel know that the experience is usually an invitation to challenge ourselves, to change our perspective about our lives, and to reassess meaning. We often return from these experiences with personal realizations, and the process of recounting our travel stories is as much about sharing those realizations as sharing the sense of beauty or interest in the place visited.

Strangely enough, while almost everyone tells good travel stories, it is often difficult to make an effective multimedia piece from these stories. We rarely think about constructing a story with our photographs or videos in advance of a trip. And we do not want to take ourselves out of the most exhilarating moments by taking out a camera and recording. Before your next trip, think about creating a story outline based on an idea prior to your visit, as well as what sorts of images, video, or sounds would be useful to establish the story.

Accomplishment Stories

Accomplishment stories are about achieving a goal, like graduating from school, landing a major contract, or being on the winning team in a sporting event. These stories easily fit into the desire–struggle–realization structure of a classic story. They also tend to be documented, so you might find it easy to construct a multimedia story. Televised sporting events have taken up the accomplishment story as a staple, and it might be helpful for you to carefully examine an “Olympic moment” to see how they balance the acts of establishing information, interviews, and voice-over:

– What was the event (time, place, incident, or series of incidents)?
– What was your relationship to the event?
– With whom did you experience this event?
– Was there a defining moment in the event?
– How did you feel during this event (fear, exhilaration, sharpened awareness, joy...)?
– What did the event teach you?
– How did this event change your life?

The Story About a Place in My Life

Up until this century, 90% of the world’s population died within a ten-mile radius of the home where they were born and raised. While this now might be difficult for us to imagine, our sense of place is still the basis of many profound stories. One of the earliest interactive storytelling websites, 1,000 Rooms, a German-based project, invited people to submit a single image of a room in their home and tell a story about their relationship with it. Hundreds of people responded with their own intimate stories. You may have a story about your current home, an ancestral home, a town, a park, a mountain or forest you love, a restaurant, store, or gathering place. Your insights into place give us insight about your sense of values and connection to community.
The Story About What I Do

For many people with professional careers, a life story is shaped by their job. Author and oral historian, Studs Terkel, collected a series of interviews in his book, *Working*, to demonstrate that we all have unique ways of perceiving and valuing what we do. And while jobs help to give some people a sense of identity, people also refer to their hobbies or social-commitments when thinking about who they are.

A good story often comes from looking at the familiar in a new way and with a new meaning. The details of the tasks, the culture of the characters that inhabit our workplace, or our spiritual or philosophical relationship to our work or avocation can lead us into many stories.

- What is your profession or ongoing interest?
- What experiences, interests, and/or knowledge in your previous life prepared you for this activity?
- Was there an initial event that most affected your decision to pursue this interest?
- Who influenced or assisted you in shaping your career, interest, or skill in this area?
- How has your profession or interest affected your life as a whole (family, friends, where you live)?
- What has been the highlight of your vocation?

Other Personal Stories

Recovery Stories

Sharing the experience of overcoming a great challenge in life is a fundamental archetype in human story making. If you can transmit the range of experience from descent, to crisis, to realization, then you can always move an audience.

Love Stories

Romance, partnership, familial or fraternal love all naturally lend themselves to the desire-struggle-realization formula. We all want to know how someone met their partner, what it was like when the baby was born, or what our relationship is with our siblings and parents. We constantly test other people’s experiences in these fundamental relationships to affirm our own. These are also stories that tend to have plenty of existing documentation.

Discovery Stories

The process of learning is a rich field to mine for stories. The detective in us gets great pleasure in illustrating how we uncovered the facts to get at a truth, whether it is in fixing a broken bicycle or developing a new product.
As you decide what story would best serve your needs, keep in mind that these categories are in no way sacrosanct, and they intersect in a number of ways. It is also probable that you will come up with your own additional categories or other ways of dissecting the stories in your mind.

**Don’t Just Sit There…**

One of the hardest, but most important thing to do is get started. Because many of these stories ask us to reveal things about ourselves that make us feel vulnerable, putting together a story can be a procrastinator’s paradise. Just get up, start answering questions on a tape recorder, write things down, gather up the photos, review your videos, and bounce your ideas off of your friends and family.

Life is full of stories, but you may not have a lifetime to capture them as movies, so, go for it!
2 Seven Steps of Digital Storytelling

During the first few years of our workshops, we would discuss with participants what made a story a digital story, and what made a digital story a good digital story. We came up with seven elements that outlined the fundamentals of digital storytelling and discovered that formally presenting them at the beginning of workshops greatly improved the process and the stories told.

Our emphasis over the years has been to help storytellers find the story they want or need to tell, and then help them clearly define that story in the form of solidly written script. For many storytellers, this process of clarification has proven to be a transformative experience, and for us, a truly rewarding journey. We now look forward to further refining this process and evolving the genre. And as we hold onto our original commitment to help storytellers sculpt a focused piece of personal writing, we will discuss what makes a story a digital story, and what makes a digital story a good digital story.

To that end, this rewrite of the elements reflects where we stand in this journey. It is not only a renaming and reordering of the elements, but a complete rethink of our approach to digital storytelling. And because we view the storytelling process as a journey, we feel that framing our approach around the metaphor of “Steps,” rather than “Elements,” will more practically guide storytellers along the path of creating a meaningful digital story.

We want stories. We love stories. Stories keep us alive. Stories that come from a place of deep insight and with a knowing wink to their audience, and stories that tease us into examining our own feelings and beliefs, and stories that guide us on our own path. But most importantly, stories told as stories.

What’s new in this rewrite is the idea that we are helping our storytellers fully visualize their story as a finished piece before they begin to write their script. This means that during our group process called the Story Circle, which is discussed at length later in the book, we want to help each storyteller not only find and clarify the story being told, but also check in with them about how they feel about it, identify the moment of change in their story, then use that to help them think through how the audience will see and hear their story in the form of a digital story. And finally, after the Story Circle is completed, and the storyteller has had some time alone with his or her thoughts, they can then let all of these considerations inform them as they sit down to write.

Step 1: Owning Your Insights

We want to help storytellers find and clarify what their stories are about. We often start with the question: “What’s the story you want to tell?” and then as a follow-up, “What do you think your story means?” We want to hear not just what the story is about in the obvious sense: “It’s about my mom, my vacation, my first real job...” But what it’s really about: the storyteller, as the person who lived through the story. And what it’s about between the lines. “This story is about my toaster...but really it’s about
losing my mom to cancer when I was five ... but it’s really about how that experience taught me that I am given chances to learn to trust again, over and over.”

Finding and clarifying what a story is really about isn’t easy. It’s a journey in which a storyteller’s insight or wisdom can evolve, even revealing an unexpected outcome. Helping storytellers find and own their deepest insights is the part of the journey we enjoy the most. This process can take time to unfold through check-ins and downtime during the duration of a multi-day workshop. Other questions that we ask to help storytellers are simple to ask, but can be difficult to answer: “Why this story? Why now? What makes it today’s version of the story? What makes it your version of the story? Who’s it for? Who’s it to? How does this story show who you are? How does this story show why you are who you are?”

Finding and clarifying stories helps people to understand the context of their lives. This process of self-reflection helps move from an awareness of “I am” to a deeper awareness of “I have been ... I am becoming ... I am ... and I will be...” As life proceeds and is reflected upon, changes can be better understood, and stories have the chance to ripen. Events from the past that may confuse a storyteller hold dormant insights that can be better understood through the realization of self-narratives. And this can happen over the course of years, or from one day to the next. This can even happen in a single moment through the act of hearing another’s story of insight, and it can bring those dormant meanings to light, elucidating layers of meaning.

Our Denver Office Director, Daniel Weinshenker, borrows an aphorism from John Gardner when he facilitates storytelling workshops. All stories, they both agree, can really be boiled down to one of two types: 1) “A stranger came to town...” or 2) “We went on a vacation.” In other words, change came to you or you went towards change. These stories, in essence, fall into the widely used archetype of the symbolic journey, the journey of self-understanding. And while stories oftentimes have a journey built into them, it is important to recognize that that journey occurs for both the storyteller and the audience alike.

When we hear stories, we listen for answers that we can relate to our own lives. Honoring self-narratives through creative expression with an audience in mind, even an audience of one, offers the opportunity to not only record and string together your insights, but change how others think and feel. The way you tell a story depends on the audience. What you are trying to say, and how you say it, depends on who is listening, what they already know and don’t know, and what you want them to know. What may be a story intended solely for you may end up being a story that changes someone else’s thoughts or feelings. And conversely, what may be a story for someone else may end up changing the way you think or feel.

In traditional storytelling, it is commonly understood that the purpose of a story is to teach a lesson or moral. For example, if you wanted to teach a lesson to a group of children about the dangers of fire, you would tell them a story relating to fire, maybe an encounter you had in the past, so that they could better understand the danger. However, artificial intelligence theorist Roger Schank tells us that through storytelling it is in fact the teller, rather than the listener, who seeks to learn from the story told. And through the teller’s repeated sharing of their story, listeners ask questions, make comments, and tell their own stories in response, which then provide the missing pieces to help the teller find a deeper meaning in their own story. This process allows the
storyteller to own a more complete version of their story and move on.

But what if the story you’re trying to tell isn’t really yours? What if it’s not about “my” anything—“my job, my mom, or my vacation.” And instead, it’s about “ours?” “Our life together, our divorce?” Or what if it’s about “theirs?” “Their community center, their after-school program?” What then? What questions do we ask these storytellers to guide them on their journey? Reread those questions that we ask about clarifying the story—those questions that are simple to ask and hard to answer—and what do you think? We ask them all. Yes, all. In particular, we listen for the answers to these three questions: What makes it your version of the story? How does this story show who you are? And how does this story show why you are who you are? Here’s Esperanza’s journey of how she found and clarified the story she wanted and needed to tell:

Esperanza has decided to make a story about her non-profit, Familias Unidas, a community organization assisting low-income Latino families with negotiating the social service systems.

From the organizational brochure, and from all the grant proposals she has written, she has a great deal of information about why her organization exists and why it deserves continued community support. She also has ten years of photographs from her work with community members, special events, staff members, and the several times the organization has been recognized with awards.

But as she thinks about the purpose of her story, she realizes that the organization’s mission statement fails to capture the emotional essence of what they truly do, or why she’s even a part of it. If the digital story is going to be presented to their supporters at the Christmas fundraiser, and then be placed on the website, it needs to move people and not just present a list of activities, goals, and objectives.

Esperanza decides to create a portrait of the Sanchez family, one of the families Familias Unidas has worked with. When she goes to meet with them, they express interest, but as they talk about the role of Familias Unidas in their lives, Esperanza realizes their story only touches on one or two of the six programs the organization offers. She realizes that she needs several families to capture a broad enough view about the organization in order to connect with the different stakeholders in her communities of support. “This is so much work,” she thinks, “and this will never get done.”

She is the director of the program, and as it is, she barely has time to work on the project. That night, she speaks with her partner, Carolina, who laughs about how Esperanza is always getting overwhelmed. “This is just like how you started the whole thing, fresh out of college,” Carolina says. “You were just full of ideals. You started helping a few of your cousin’s friends get some paperwork turned in for the local clinic, and the next thing I know, you were helping everyone in the barrio. You hardly slept then.”

Esperanza remembered these times, how passionate she felt, and how her passion inspired others to take up this work and to give donations to support it. “Maybe that’s the story,” she says aloud, “not just what we do, but why we do it, why I do it, and how caring starts with just one person.”

She calls her cousin and asks if he would be willing to tell the story of those first projects. He says he would be honored. She starts writing, and the words flow. From this beginning story, she connects the Sanchez family’s experience to show how the program
became legitimized, and she finishes with a reflection on her own growth and the
gifts that this work has given her:

At midnight, she closes her laptop. Esperanza sees the movie playing in her head. “I
know just the images to use.”

**Step 2: Owning Your Emotions**

As we help storytellers find and clarify what their stories are about and ask them
to consider the meaning contained within their stories, we also want to help them
become aware of the emotional resonance of their story. By identifying the emotions
in the story, they can then decide which emotions they would like to include in their
story and how they would like to convey them to their audience.

To help storytellers identify the emotions in their story, we ask a series of questions
regarding their process: “As you shared your story, or story idea, what emotions did
you experience? Can you identify at what points in sharing your story you felt certain
emotions? If you experienced more than one emotion, were they contrasting?” And
as the storyteller gains awareness of their emotional connection to the story, they
can begin to think about how others might connect on an emotional level. To help
storytellers decide how to convey emotional content, we ask a second set of ques-
tions: “Which emotions will best help the audience understand the journey contained
within your story? Is there an overall tone that captures a central theme? Can you
convey your emotions without directly using “feeling” words or relying on clichés to
describe them? For example, how can you imply the idea of happiness without saying,
‘I felt happy?’”

When we reflect on the emotions within in our stories, we realize that they can be
complex, and with this realization we oftentimes discover deeper layers of a story’s
meaning. For example, stories of wedding celebrations can also be about overcoming
loneliness and facing new struggles in forging lasting partnerships. Joyous births can
also be about working through the fear of shouldering new responsibility. Restful va-
cations can also be about recognizing the stress that shapes our daily lives. Grieving
the loss of a loved one can also be about appreciating the wisdom that they have im-
parted. Thus having an awareness of the contrasting and complex nature of a story’s
emotional content will not only help get us in touch with the core of the story’s mean-
ing, but also determine which emotions to include, and in what sequence to present
them to help the audience understand the story.

Taking ownership of the emotions contained within a story will also help the audi-
ence connect on a deeper level. But the inclusion of emotions doesn't mean that your
audience will meaningfully connect to it, so emotion alone is not the goal. When we,
as an audience, hear a story that has an exaggerated tug to emotion, we read it as
dishonesty. Conversely, if it seems devoid of emotion, without a hint of struggle or
conflict, then we don't believe it either.

So when a storyteller wants the audience to pause long enough to listen, to listen
deeply and trust them as a storyteller, they have to convey a sense of awareness and
ownership of the emotions contained with their story. We want to help the storytellers
be as aware of their emotions as they can be, and demonstrate to the audience that
they believe in what they are saying, and are “in” their story. Unless the storyteller trusts that the audience will connect with the underlying issues of their story, they may not be fully honest with themselves or the audience.

Most audiences know that if the storyteller chooses to leave out information and describes details through inference instead of evidence, then there must be a good reason. But they can also tell the difference between being reticent and indirect, and being purposely superficial. The storyteller may or may not want to disclose intimate details, but it is beneficial for them to demonstrate a respect for their audience.

In story work, as a storyteller reflects on their sense of what the story is about and becomes aware of its emotional content, they must also choose the just-so voice that suits it. And rather than using language constructed for a society that can be judgmental and threatening, the storyteller instead peels back the protective layers and finds the voice that conveys their emotional honesty, as if speaking to a trusted friend.

Within every community, and within every shared experience, there are many different ideas of what it means to disclose information. Therefore, knowing your intended audience can shape the emotional content of your story. The degree of emotional content is also culturally specific, as storytellers are familiar with the codes and clues within their own communities. When a storyteller trusts that they are listening deeply to their own heart and imagines the thoughtful appreciation of a specific audience, they will share what is appropriate to share.

People are rarely presented with opportunities for deep, connected listening, and if they are presented with them, they often don’t take the opportunity to listen with a depth that matches that of the speaker’s. Therefore, our practice is predicated on providing a safe space for telling and listening to emotionally honest stories. Stories that emerge in this sacred space of deep listening can source our emotional core, and can surprise both the teller and the listener. Storytellers in our workshops often choose to address difficult issues—to wink at, stare, and sometimes engage, the demons inside. When you visit the storycenter.org website and view the digital stories we have chosen to share, you will see that they are diverse in theme but consistent in their emotional honesty. To paraphrase Boston-based storyteller, the late Brother Blue, the stories feel like they are traveling the shortest distance from the heart of the storyteller to the viewer’s own heart.

**Step 3: Finding The Moment**

Finding and clarifying the insight and emotions of the story can be the most challenging and rewarding part of the storytelling process. As the storyteller becomes clear about the meaning of their story, we want to help them tell their story as a story by identifying a single moment that they can use to illustrate their insight. To help storytellers find this moment, we ask a series of questions: “What was the moment when things changed? Were you aware of it at the time? If not, what was the moment you became aware that things had changed? Is there more than one possible moment to choose from? If so, do they convey different meanings? Which most accurately conveys the meaning in your story? Can you describe the moment in detail?” Once this moment of change is identified, we help storytellers determine how it will be used to shape the story.
Our lives comprise an infinite number of moments, and some of those moments are loaded with more meaning than others. The moment of change might be the most memorable or dramatic moment, or it may have occurred without the storyteller even noticing it at the time or grasping its significance in their life. Whether the storyteller became aware of it at the time or in reflection, we want to help them find the moment of change that best represents the insight that they wish to convey. And depending on the story, they may choose from any number of moments as an entry point into their insight. For a story about trust, for example, a storyteller might choose the moment that he or she lost trust in a relationship, or regained it, or recognized its importance. Or there may be a single, obvious moment of change. For a story about a loved one’s death, for example, it may be when the storyteller’s phone rang and they got the news.

Reflecting on your personal insights and emotions allows you to find the moments of change that have occurred in your life. As mentioned in above discussions, audiences like to hear about change because they’re looking for answers about change in their own lives. However, rather than listening to someone share their wisdom and insights with us through a report or an essay on the morals or lessons learned, we prefer when it is told to us as a story.

Compelling stories reproduce the insight and experience of the storyteller while prompting the audience to ask questions about their own experiences and look for larger truths. Compelling storytellers construct scenes to show how change happened, how they dealt with it, what they were like before the change, and what they are like after. A storyteller sharing their insight within a story says to the audience, in essence: This is what has happened and this is what I have learned. By building a scene around the moment of change, the storyteller is “showing” rather than “telling.”

“Showing” through scene is part of the pleasure for the audience as they are drawn into the moment of change and actively construct their own interpretations. If you can paint the audience a portrait of both you, and your experience of the moment of change, then you are creating a scene. As you recall the moment of change, ask yourself these questions: What do you see? What do you hear? What’s being said? What are your thoughts? What are your feelings? What is the context behind your feelings? Have you been in this situation before or since? Have you been in these surroundings, or had these thoughts or feelings before or since? When? Is that part of this story?

How much of a scene you build around the moment of change, how you integrate that scene into the story, and the total number of scenes depends on how much information the audience needs to know in order to understand. What happened before that moment, what happened after? Does the audience need more or less information? What are the key details that will help the audience appreciate the moment of change? Over the course of a three to five minute piece, a digital story can consist of a single scene, or it can consist of several. Because the format is relatively short, it’s important to select your scenes with care and establish them concretely to ensure that they are contributing to the overall piece.

As the audience, we uncover meaning in the way the storyteller has shaped their story. The events of the story lead us to conclusions but don’t constrict our own discovery, and the moment of change and the scenes built around it lead the audience to
a river of understanding. However, they are the ones who have to jump in. And in this way they become participants in the narrative—to make that jump, to fill that void.

**Step 4: Seeing Your Story**

Finding the moment of change in your story and describing it within a scene is the starting point to telling the story as a story. However, because we help storytellers share their stories in the form of a digital story, we also want to look at how the use of visuals and sound bring things to life for the audience. There are many choices that come along with designing how the audience will “see” and “hear” the digital story. Let’s begin with visuals. We discuss visual choices early in the story conception process so that storytellers consider how the use of images will shape their story. In order to “see” their story, we help storytellers describe the images that come to mind, understand what those images convey, find or create those images, and then determine how best to use them to convey their intended meaning.

As part of this process of creating a visual narrative, we ask storytellers: “What images come to mind when recalling the moment of change in the story? What images come to mind for other parts of the story?” At this point in the process, we want storytellers to simply call these images to mind, whatever they are, without being concerned about whether or not they exist as actual photos. Next, we want storytellers to explore the meaning that these images convey, and so we ask them: “Why this image? What is it conveying to you? Is the meaning explicit or implicit? Does it have more than one meaning? If so, can you describe the multiple meanings?” Once the storyteller is clear about the meaning they want to convey with their visuals, we help them decide how they will find or create these images, and how they will use them. We ask: “Do you already have these images or will you need to find or create them? How could you use the images that you already have to convey your meaning?”

In her first digital storytelling workshop, designer and filmmaker Lina Hoshino decided to tell her mother’s story about the evolution of her name into Chinese and Japanese as a result of the Japanese Occupation and then the Chinese Civil War in Taiwan. At one point in her digital story, Lina shows the Nationalist Party leader, Chiang Kai-shek, in a series of images as she discusses the history. But rather than simply showing the entire formal portrait that she found in the public domain (as part of the F.D. Roosevelt Library), she chose to present the image as a series of crops and a pan.
Chapter 2: Seven Steps

The original image that she found (Figure 1) shows the stately dictator seated with a medal on his uniform. Lina dissects the full portrait into three cropped details that feature the medal (Figure 2), the resting fist (Figure 3), and the other hand holding the decorated hilt of the sword (Figure 4). After these three images, she then shows the portrait at shoulder height (Figure 5) and then slowly pans in and slightly to the left ending on the final frame (Figure 6).

Compositionally, the shots move from the medal in the left third, to the fist in the center, to the hilt/hand in the right third. The next shot, the cropped portrait of Chiang, remains in the right third of the frame. Dynamic motion across the frame is created with these detailed stills. In contrast, the slow pan returns our eyes towards the left side of the frame as we are carried along the gaze of the subject. Chiang’s Kuomintang army came to Lina’s mother’s home island of Taiwan with imperial will. Lina amplifies this through her cropping of the image to the focus on the visual representations of power—details of the medal, gloved fist, martial hilt, and gaze of the leader.

When thinking about creating a digital story, many storytellers who are new to the form will simply envision an image that mirrors each of the different points throughout their entire narrative. These types of literal or direct images that are used to illustrate a story are called explicit imagery. Explicit imagery is useful for conveying the necessary details of your story or helping to set the scene for your audience. For example, when a storyteller says, “This is the house where I grew up” and shows a photo of a house, the audience understands that this is literally “the house.” By intentionally choosing to show the house, the storyteller is also letting us know that it is important for us to see this house in order to understand the details of their story. When considering which images to use and how to use them, we want to help storytellers be clear about the important details that would not be understood or appreciated without the use of explicit imagery. To do this, we ask: “Would the audience be able to understand the story’s meaning without this image?”

However, not all aspects of a story's meaning are best conveyed through the use of explicit imagery. When considering an image, a storyteller can ask: “Is this image conveying another layer of meaning?” If so, then the image has an implicit use. Implicit
imagery is useful for implying or representing another meaning beyond an image’s explicit or literal meaning. Two common techniques for a storyteller to convey their meaning through the use of implicit imagery are visual metaphor and juxtaposition.

When calling images to mind from the moment of change in their story, a storyteller may select an aspect of the scene that stands out for them, but is not an explicit illustration of the event. For example, when sharing a story about losing a childhood home and describing the moment of change, a storyteller may find that a nearby tree, rather than the house itself, is the dominant image they call to mind. As they consider the significance of the tree in their story, they may discover that it represents the idea of stability in their life. The use of an image of a tree to convey stability in their story is a visual metaphor.

The images you choose and the way you combine them will work to create additional layers of meaning. The placement of one image followed by another to create a new layer of meaning is called juxtaposition. An image of a house followed by an image of cardboard boxes, for example, conveys moving. However, until we know more of the story, we may not know if the message is really about loss, freedom, or maybe both. If the next image is an open road, this could represent freedom. Audiences “read” the juxtaposition of visual images as having implicit meaning that goes beyond what one of the other images explicitly means on its own.

A limitation of material can spark creativity. A storyteller may not possess photos from the major scenes in his or her life. Most people have pictures of their weddings, but who has pictures of their divorce proceedings? Storytellers in our workshops may have only a few photos to work with, or none at all. But paying attention to the images that come to mind when initially sharing the story will help lead the way in creating a visual narrative. And although production time of new material is limited in our workshops, if storytellers are clear about what they want to create, then taking pictures, shooting short segments of video footage, or drawing and scanning images are all good options.

The length of our workshops is typically limited to about 3–5 days. This constraint on time can help the creative process, but it can also lead to choices about images that are less often considered than the words they accompany. For example, composing a visual narrative with images grabbed from an Internet search can be a quick solution, but oftentimes these images can take away from the integrity of the story. But more importantly, if storytellers have not allowed time early on to see how their images can do some of the heavy lifting of storytelling, they may find they would have altered their script to work with the images they ultimately use.

Well-chosen images act as mediators between the narrative and the audience. As stated in earlier discussions, audiences enjoy stories that lead them to a metaphorical river of meaning and require them to “jump in” in order to make their own connections. Images can grab the hands of the audience and show them the river’s immensity. And images have the power to reveal something to the audience that words just can’t say.
Step 5: Hearing Your Story

We’ve just looked at how visuals help bring a story to life. Now, let’s look at sound. The recorded voice of the storyteller telling their story is what makes what we call a “digital story” a digital story—not a music video or narrated slideshow. By this point in the process, the emotional tone of the story has been identified, and sound is one of the best ways to convey that tone—through the way the voice-over is performed, the words that are spoken, and the ambient sound and music that work with the narrative. When considering the use of sound, we help storytellers by asking: “Beyond the recorded voiceover, would the story and the scenes within it be enhanced by the use of additional layers of sound? Would the use of ambient sound or music highlight the turning point in your story?”

In digital stories, voice not only tells a vital narrative but it also captures the essence of the narrator, their unique character, and their connection to the lived experience. One’s voice is a truly great gift as it is a testament to one’s fragility and strength. But why does voice matter so much? In a speech, for example, we are listening for an applause line. In a lecture, we are listening for the major points, or an outline of information. But in a story, we are listening for the shape of an organic, rhythmic quality that allows us to drift into reverie. Here we have a complex interaction between following the story and allowing the associative memories the story conjures up to flow around us. If an image acts as the hand that leads us into the river, the voice is the riverbed below our feet.

When writing a voice-over, it is important to remember that the piece, in its final form, will move from being words on the page to being spoken aloud. And unlike a speech or spoken-word performance, this spoken narration will exist within a digital story complete with accompanying images and possibly other layers of sound. Because of this film-like format, storytellers want to pay special attention to their choice of words and phrasing and the impact they will have. Less is often more, both in descriptive detail, and in the formality of language. This form is served well by the storyteller mimicking how they speak when they tell a story to a friend, unscripted and unrehearsed, for the first time after having just experienced it. They use incomplete or broken sentences, interrupted thoughts, and a haunting precision of choice words that make the details come alive for both the teller and listener. The more the spoken voice is inserted into the written script, the more the qualities of a person will come across and pull the audience into the story.

Digital stories that have the recorded voice as the only audio track can be tremendously powerful at conveying tone and meaning. When considering whether or not to add layers of sound, we help storytellers approach the process by starting with as little additional sound as possible and then ask: “Is this enhancing the story, or taking away from it?” If it is enhancing the story, then add a little more and ask the question again. One way to add some sound is to think about the ambient sounds that come up when recalling the moment of change in the story. When we listen to the scenes in our stories, they may include sounds that exist in the background of everyday life—traffic, birds, airplanes, voices, for example. These types of sounds help create a sense of place for the audience. There is no question that ambient sound can add complexity to a story. They help to set the scene and feeling, and its addition helps the audience better understand the significance of a scene, especially if there is a dominant sound that best captures its essence.
When creating these ambient sounds, it may be simplest to record them from the available sounds nearby rather than search for pre-existing recordings. Also, the use of your recorded voice or that of another person to create additional layers of ambient sound can be very powerful, yet very simple.

As with ambient sound, storytellers can consider how the minimal use of music can enhance a story by giving it rhythm and character. From an early age we become aware that music can alter our perception of visual information. We see how music in a film stirs up an emotional response very different from what the visual information inherently suggests. By trying out different pieces of music you can change not only the story’s tone, but also its meaning and direction. The use of instrumental music, whatever the genre, can enhance the style and meaning of the story’s text and visual narratives without competing with the voiceover. While popular lyrical music may work, mistakes are sometimes made in mixing the story of the song and the voiceover in a way that gives an unintended conflict of meaning. However, by intentionally juxtaposing the messages, you may create another layer of meaning that adds depth and complexity to your story.

In our experience, storytellers have an intuitive sense of the music that is appropriate for a digital story. People walk around with songs playing in their heads which can set the mood of one’s day, change the way we perceive spaces and places, and establish a rhythm for our steps.

---

**A Note on Copyright**

Your writing, recorded voice and personal images belong to you. When you consider using others’ music, you cross into the territory of deciding what should be the appropriate fair use of the copyrighted material. Put simply, whatever the music choice, honor it by providing a credit at the end of the piece. If you are going to make money directly or indirectly by the presentation or distribution of the piece you have created, then you should have the artist’s permission to use the music. Fortunately there are a growing number of legal online music collections that provide free and affordable media, as well as software to assist you in designing a soundtrack that is wholly yours.

---

**Step 6: Assembling Your Story**

At this point in the process you have found and clarified what your story is about and how it sits with you today. You have also established the overall tone you want to convey. You’ve identified a moment of change and begun making choices about how to use visuals and sound to bring the story and scenes to life for your audience. Now you are ready to assemble your story by spreading out your notes and images and composing your script and storyboard. This requires answering two questions: How are you structuring the story? And, within that structure, how are the layers of visual and audio narratives working together? But those aren’t simple questions. Where do you start? Let’s look at the question of structure. You’ve identified the moment of change,
but at what point in the story will it appear? Is it at the beginning, middle, end, or is it divided up at different points throughout the story? Or is it the entire story? What other details or scenes are necessary to provide context for the moment of change? And in what order will sequence all this information?

When we tell stories for the first time after we have just experienced an event, we may want to launch right in, but if we see a confused or disinterested look on our listener’s face then we should know to stop and say, “Wait, let me back up. In order to appreciate what I’m telling you, you have to know this...” In essence, we understand that the listener is lacking some important information in order to “get it,” and so we choose to provide our audience with a backstory, or exposition. In going back to fill in details for our audience, depending how well they know us and know our life’s ongoing narrative, we may find ourselves believing that we need to tell them everything, but quickly realize that this is impossible. A complete telling of every bit of detail is never really “complete,” and in the process we begin editing, choosing which details we feel are the most necessary to include in order to construct meaning. In this real-time editing process, we are absorbing our listener’s experience and making many choices about where their interest is peaked, where they seem lost, and where they are with us on the journey.

This process of telling stories and reading the audience’s reaction is critical to understanding story structure. It helps answer the questions: What are the necessary parts of my story? How will telling this part shape the story differently or take it in a different direction? Knowing which pieces of information are necessary to include allows us to then determine the best way to order those pieces and keep our audience engaged. As the storyteller, we know where the treasure (insight) is hidden, and we are giving our audience clues to find it.

The joy of storytelling comes in determining how much to tell them and at what point. As our narrative literacy progresses from the comprehension of nursery rhymes towards a more intricate understanding of complex narratives, we desire more subtlety in a story’s form. As the audience, we are less likely to look for intended morals and spelled-out meanings, and will instead draw from it what we find important. But presenting the conflicts, problems, or unanswered questions with subtlety requires not only identifying the right conflict but the right amount of conflict.

Daniel Weinschenker describes building tension in a story’s structure by using a cat analogy: When you are playing with a cat and holding a string for it to chase, if you make it too simple, it will get offended, or bored, and likely walk away. If you make it too difficult and never let it catch the string, then it will give up. But the joy in the game is finding the balance between making it just hard enough to challenge the cat, keeping him engaged in trying to catch the string, and letting him savor it when he does.

In other words, don’t give away too much information all at once. Allow your audience to enjoy the challenge. And rather than establishing a chronological telling of events with the moment of change positioned as the story’s climax, you might instead try moving the moment of change to the beginning with little or no context, which may leave the moment hanging to pique the interest of the audience, and then go back and fill in more and more details and scenes and allow the audience to piece together the meaning and resolution. However, to do this you need to pay special attention to your audience’s experience.
For example, if you begin the story with something provocative and don’t reveal the piece that explains it until the end, you may need to remind the audience about the question in the first place so they can savor the ending.

Once the basic structure of the story is outlined, the next step is scripting and storyboarding, or in other words, laying out how the visual and audio narratives will complement each other over the duration of the piece to best tell the story. The most common approach that storytellers take to planning their story in our workshops is to write notes in the margins of their script in order to reference where certain images or sounds will occur. In the next chapter we discuss storyboarding in detail, and provide a sample template that includes a series of tracks that you can fill in with notes about the visuals and their effects, voice-over and sound. As you determine how your visual and audio narratives are working together within each of these layers, ask yourself: Do I want them to be redundant, complementary, juxtaposing, or disjunctive?

Considering the above will not only help you determine how the various layers contribute to the story, but it will also help you economize each in relationship to one another. You can ask yourself: If I have an image that conveys my meaning better than words can, how can I use my words to tell another aspect of the scene? In digital stories, the way we combine the layers to convey meaning allows us to economize the presentation of information and lets our audience make the connections. For example, if we hear a phone ring and the storyteller says, “I held my breath as I got the news…” and we see a photo of a loved one fade to black, we may understand that the storyteller is conveying a sense of loss. This process of the audience understanding bits and pieces of information as a single idea is called “closure.” And as we edit down our scripts and choose each of our images, we need to think about how we set up opportunities for the audience to provide closure with each layer of the story independently, as well as in relation to each other. Oftentimes, this means your script requires fewer words. In an effort to help our storytellers, we provide formal constraints in the production of their digital stories: A word count of 250–375, and fewer than twenty images or video segments. This type of creative limitation helps the storyteller figure out what’s most important in his or her story, while also helping to organize their time in the production process.

After your story edits are assembled, pacing is one of the final considerations in creating a digital story because it requires an assessment of how all the layers of information are working over the entire length of the piece. When pacing your story, ask yourself: How does the pacing contribute to the story’s meaning? How would pace, or rhythm, bring emphasis to the moment of change?

A story’s rhythm conveys an added layer of meaning. A fast pace with quick edits and upbeat music can convey urgency. A slow pace with gradual transitions and extended shots may convey calmness. A mechanically paced story may work nicely for a piece about the monotony of an assembly line job, but for an adventure story it will flatten the experience of the joys and hardships that the audience is expecting to savor. Adjusting the pace of your story provides an opportunity for the audience to listen more clearly. Stories can move along at an even pace, stop to take a deep breath, and then proceed. Creating space for silence, for example, provides the audience with time for all layers of the story to be absorbed. Even if you think your story is paced too slowly, chances are your audience will appreciate more time than you think to allow their minds to explore the thoughts and emotions that are being stirred within them.
The assemblage of your story takes time, and isn’t easy. However, our best advice is to keep it simple.

Digital stories contain multiple visual and audio layers.

The visual layers are:
- The composition of a single image
- The combination of multiple images within a single frame, either through collage or fading over time
- The juxtaposition of a series of images over time
- Movement applied to a single image, either by panning or zooming or the juxtaposition of a series of cropped details from the whole image
- The use of text on screen in relation to visuals, spoken narration, or sound

The audio layers are:
- Recorded voice-over
- Recorded voice-over in relation to sound, either music or ambient sound
- Music alone or in contrast to another piece of music

Step 7: Sharing Your Story

At this point in the process, the layers of the story have been assembled. Finding and clarifying the insight, and creating the digital story have taken the storyteller on a journey of self-understanding. The story and the insight it conveys may have evolved throughout the process. Therefore, it is important to take time now to revisit the context in which the story was initially described in order to determine the relevant information to include when the story is being shared. To help storytellers do this, we ask: “Who is your audience? What was your purpose in creating the story? Has the purpose shifted during the process of creating the piece? In what presentation will your digital story be viewed? And what life will the story have after it’s completed?”

Before the final version is exported, consider the audience once more, but this time in terms of how you will present the digital story. You may be planning to show your it to one individual, one time, for a specific reason. Or you may be planning to share it online with as many people as possible. But for most storytellers their plans fall somewhere in between, or they may not yet know the full extent that they will eventually share their story. But in any event, it’s important to consider the contextualizing information you want to convey to your audience, both as part of the digital story and alongside it.

During our workshops we ask if storytellers want to say anything before their story is screened. Some say, “No, I’ll let the story speak for itself,” and others tell a bit more in order to set it up. When we share stories on our own website we provide a short description of the story and the storyteller’s responses to a few questions: Tell us a little about yourself. Why did you choose this story to tell? How have you changed as a result of telling this story?
Knowing more about the story, the storyteller, or both, can reveal a new depth of appreciation by the audience. For example, the First Interlude of this book features Monte Hallis’ Tanya, a story about how Monte discovers the meaning of friendship through knowing Tanya during her fight with AIDS. The backstory she provided in person before her story was screened at the workshop was that Tanya had passed away. The story around a piece changes and expands over time. In another example, the Fourth Interlude of this book highlights a young man’s story about the sacrifices his immigrant grandparents made in order to provide a better life for their family in a small town in Texas. The story ends with a photo of the storyteller in his cap and gown but the back-story reveals that he was accepted to Brown University and returned to mentor young people in his hometown.

Considering your audience at this point in the production process may alter how you complete the final edits. If you know who the audience will be for your piece and what they know about you, then it will help determine how much context you decide to provide about the story. Contextualizing information can be either within or outside of the story’s script. If your intended audience already knows certain details about you and your story, then it will help determine which details you include in your script, and which details can instead be revealed through outside contextualizing information. You may choose to contextualize the story outside of the script, but still within the actual piece, by providing a title screen at the beginning and text screens at either the beginning or end that display additional information. This is a common technique used in films in order to set up a story, or communicate what happened to a character or situation thereafter.

Being clear about your purpose in creating the story and how it may have shifted during the process of creating the piece will help you determine how you present and share your story. In our programmatic custom workshops, sometimes the storytellers are recruited with the understanding that their stories will address a certain topic and be presented in a specific context. For example, in a project with foster youth, their host organization may ask if they would like to participate in a workshop in which they tell a personal story about their idea of the “permanency” of family, and have their story be included in a training program for social workers. The storytellers are informed about the expectation before agreeing to attend the workshop. And within the workshop, they are invited to share their larger life story during the first of two Story Circles. Then during a second Story Circle they focus their story in a way that is meaningful and timely to them, and also addresses the specific purpose with which the stories will be to shared. Knowing that their story will have this additional audience and purpose will help them appropriately frame their story. In the interviews that follow in this book, Thenmozhi Soundararajan and Amy Hill both discuss the issue of presenting stories within their intended context.

If you know the presentation setting in which your audience will view your digital story, then it will help you determine what kind of contextualizing materials should accompany the piece, and will also provide more time during the digital story to focus on other content in the story. For example, if a storyteller makes a story about the successes of their afterschool program with the intention of presenting it on their organization’s website, they know that the audience will be able to learn more by exploring the information online, and therefore won’t need be concerned with including it in the digital story.
Whether your piece will be integrated into a live or published presentation, or is but one in a series of related digital stories that you create, or one that acts as a prompt to elicit others’ stories, it is wise to prepare in advance by thinking through all of the possibilities as your story goes forth to live its life.

Finally

The storytelling process is a journey. And in our workshops, we approach this journey as a facilitated group process. We believe that the connections made between people in the Story Circle help to focus and inspire each individual throughout the process. For many of the storytellers we help, the digital story they create in our workshops may be the only digital story they ever make, in part because overcoming the challenge of finding and clarifying the insights and emotions in their story is not easily done alone. Therefore, we recommend that digital storytellers connect with others to share ideas and work through these steps together.
3 Approaches to Scripting

After the first year of offering digital storytelling workshops in 1994, Nina and I saw the need to closely examine how people approached the writing process for their digital stories. Just because the subject matter was clear to a workshop participant, it wasn’t always easy to get the script written. In the last chapter we discussed the insights and structure for your story, as well as the considerations for working with multiple forms of media. In this chapter we will discuss the notion of how to find your best creative voice for self-expression in writing, about how writing happens, and about what makes the way you write unique and powerful.

As with our approach to digital storytelling in general, we find that our practice is ideally suited to group settings. And while you can use these ideas to get started on your own, success happens just as often by comparing your work to others, and by hearing a variety of examples. So find a few friends, declare yourself a writer’s group, gather once-a-week for a month, and share your writing. Your digital story will thank you for your efforts.

Our Friend, the 4 x 6 Index Card

Of all the suggestions that we have made in helping people to prepare their writing, the use of 4 x 6 index cards has garnered the most praise.

The idea is simple: Novice and experienced writers alike inevitably suffer from a malady aptly called “blank page syndrome.” The weight of filling a blank page, or more than likely, many pages, can easily crush our creative initiative, and as a result, cause us some difficulty in getting started. In our workshops, when we have found a person blankly staring at their monitors with a deer-in-the-headlights look in their eye, we like to hand them a 4 x 6 index card and say, “You have 10 minutes and only the space on the front and back of this card to create a draft of your story. Write whatever comes out and don’t stop until either the time or the card runs out.” We might also give them a prompt: “This is a post card. Choose a person that you think this story is for and write them a postcard about the story. Start with, ‘Dear ______,’

The card is small, and it is finite. It seems possible, and perhaps even easy to fill. So for the novice, in other words, we are saying, “Just get this much down, and we’ll work from there.” And for writers confident in their ability to write countless pages of prose, this exercise is a creative challenge. To them, we say, “We know you could write a novel, now just try and say it in only this much space.”

One of my favorite Mark Twain quotes is from a letter that he wrote to a friend: “Forgive me, this is a long letter. I would have written you a short letter, but I didn’t have the time.”

Shorter isn’t always easier for the mature writer. The 4 x 6 card also helps condense the narrative by breaking the story down to its most basic elements and forcing a writer to
ask, “What are my choices in the beginning? How quickly must I get into the action of
the narrative?” Usually, this approach means sacrificing the long exposition that ac-
companies the first draft of a story. But in the end, if the writing is no longer than the
front and back of a 4 x 6 card, or one double-spaced, typewritten page, it ensures that
the writing will lead to a two-to-three minute story complete with narration.

Writing Exercises

In a group process, we are proponents of writing exercises. While we are fully aware
of the potential and beauty of free writing, it’s important to have a class spend ten to
twenty minutes writing down whatever comes to their mind. I have found that the
shared themes and ideas of a prompted idea can connect people to each other in won-
derful ways.

This is my favorite prompt:

*In our lives there are moments, decisive moments, when the direction of our lives
was pointed in a given direction, and because of the events of this moment, we are
going in another direction. Poet Robert Frost shared this concept simply as “The
Road Not Taken”. The date of a major achievement, the time there was a particular-
ly bad setback, the experiences of meeting a special person, the birth of a child, the
end of a relationship, or the death of a loved one are all examples of these fork-in-
the-road experiences. Right now, at this second, write about a decisive moment in
your life. You have ten minutes.*

The writing that comes from this prompt, when it comes unannounced at the beginning
of a workshop, often goes straight to the emotional core of the author’s life. The act of
sharing of these kinds of stories can be instantly bonding for a group.

If the goal of the exercise is to prompt distant memories, we have not found a better
approach than theorist Bill Roobach’s idea of having participants in the workshop
first draw a map of the neighborhood where they grew up. Reaching back in one’s
memory to locate the layout of the streets, where friends lived, the names of friendly
or strange neighbors, the way to the store, or the secret paths to school, inevitably
opens up an infinite number of possible stories. The physicalization of a memory,
trying to remember a time by remembering the places of that time, the places you
traveled through on a daily basis, a neighborhood, a house, or a room, usually leads
quickly to events that are rich with the kinds of meaningful inspections that make
good stories.

There are innumerable prompts that might work for various situations. Here is a
short list of some themes for which prompts could also be built for powerful stories.
Books about writing are filled with these exercises, so don’t forget to pick up a few
when it’s time to delve deeper into your interest in writing beyond he digital story-
telling experience:

– Tell the story of a mentor or hero in your life.
– Tell the story of a time when “it just didn’t work”—a point, at your job or at some
other event or activity, when you would’ve been typically competent or successful,
and how that all changed when everything fell apart before your eyes.
– Describe a time when you felt really scared.
– Tell the story of a “first”—first kiss, first day on a job, first time trying something really difficult, the first time your heard a favorite song, etc.
– And of course, the old standby: What was the most embarrassing thing that ever happened to you?

These Stories from These Pictures

Digital stories often start with the pictures. Our easiest direction to anyone thinking about making a digital story is to look around his or her house and find images that provoke memories and stories that are meaningful. Then, see if there are other images around the house that are part of that story. And in the end, you will try to connect the memories that link all of these images together.

As we talk about storyboarding and structure, the notion of illustrating the script, or accentuating the writing with images, is emphasized as an outgrowth of a successful draft of the narrative. However, some people that come to the workshop have taken the absolutely opposite approach to the process. They will pull out the photos for their story, arrange them on a table, and sort them out in order from beginning to end. Then, with the story visually organized, they start writing. Is this approach effective? Of course it can be—great stories have emerged through this process.

Our only caveat regarding this approach is to consider whether or not responding to the images alone will leave out parts of a story that were never captured in any of your images. If you find that you would like to see an image in your story that you don’t have available, you can look to an illustration, or appropriately implicit or metaphorical images to capture the sense of the writing that suit the purposes of your story.

Getting into the Scene

When authors come to our digital storytelling workshops, we have them share first drafts and talk about their ideas for their stories. Oftentimes, I find myself discussing the notion of scene with the authors. As an example, I can take one approach to my own story about my father’s death:

Well first of all, let me just say, I was seventeen at the time and I had finished high school that summer. My dad had smoked three-packs-a-day, and had been trying to quit smoking for a couple of months. He was sixty-one, and had a difficult life as a union organizer working in Texas and throughout the South. But we had gone on a vacation the month before and he seemed like he was doing okay.

He came down from his bedroom saying that he had a terrible pain.

We called the doctor. The doctor said that it was probably an ulcer attack. He had had several of those. We waited. He got much worse. We decided to rush him to the hospital. It was a heart attack. He died within a half-hour. My mom was hysterical.

It was a night I will always remember.

What we have is a fairly typical set of expository contexts, and a sequence of events that most people use to casually recall a major catastrophe in their lives. This approach is a fairly direct and distanced recitation of the facts, and it usually finishes with a statement that is conclusive. In this example, the recalled memory is understated and obvious to the extreme. If this were a dramatic dialogue, a speech by an actor pretending to be natural, it would be fine.
But here is a description of the same memory that I shared at my mother's memorial in 2001, twenty-seven years after my father died:

I will never forget the sound of my mom's voice when the doctor said, “George is dead.”
“God No! No! No!”


The sound of her wail bounced off all the walls of the emergency room at Presbyterian Hospital in Dallas, bounced down the streets and through the trees, bounced out into the night sky, all the way across the universe of my young mind.

In a single moment, a single pronunciation, everything changed for my mom. It divided her life in two, and it taught me that love can reach down into the cellular essence of awareness, and with its rupture, tear a human being in half.

What differentiates these two texts for me is the fact that in the second text, I am asking my audience to immediately journey in time with me to the exact instant when it all really happened. No context, other than the assumption that “George” must be someone really important, and the feelings, best as I remembered them, that accompanied the defining moment of the experience; my mom's reaction to the doctor's words. And finally, with over twenty-five years of perspective, what that means to me now.

In the above example, I tried to take the audience into the scene at the hospital. I could have described the way it looked and smelled, where we were standing moments before the doctor came up, and what happened afterwards, but all of that was assumed when I said it was the moment that my father was pronounced dead. Instead, it serviced the quality of the writing to strip away all of the descriptive material. We have found that audiences really can build an elaborate understanding of the story if they can get a sense of the pretext of an event. Furthermore, we know that much of what seems like important background, or exposition, is in fact superfluous to what really happened and what it really felt like to be there.

Taking the audience to the moment of an important scene, one that either initiates or concludes your tale, and putting them in your shoes, is why we listen to the story. We want to know how characters react. We want to imagine ourselves there as participants or witnesses, and we want to know what someone else takes away from the experience and uses to lead their own lives forward.

This idea of scene-placement is related but separate from the terms of the specific disciplines of literature, theater and film. Dramatic scenes all have complex sets of conventions that allow us to observe the action of characters within a continuous time of the narrative. In our thinking about scene, we want to encourage people to share at least one portion of their narrative as a scene—to write as if they were there, inside the events as they unfolded, experiencing the shock, surprise, or amusement, for example, for the first time. For many stories, this strips away the superficial consideration of the events, and gets to the heart of the matter.
Chapter 3: Approaches to Scripting

Character Studies and Personal Story

We know that most of our parents are multi-faceted, complex humans. In one story, it may serve to have the parent in the classic role of the ideal mentor, thereby filling one stereotype of parenthood. In another story, the parent may be a beast, or display beastly behavior; but if we are mature enough, and we are given one small nugget of context, for example: “When they got drunk, they would be mean,” it is sufficient for us to imagine that they had good days as well. We are probably aware that the story is a cautionary tale about human behavior, not the evidence to indict the guilty party.

Lagos Egri, author of the bible of my training in dramatic theory, *The Art of Dramatic Writing*, reduced all great storytelling and theater to the author’s understanding of the true nature of the characters he invents in the world of his narrative. Like most people, when I watch a film or a play, I know when character development has been rendered ineffective when I am able to say to myself, “You know, that character would have never said those words, or behaved in that way.” In any story, it simply will not work if both characters strengths and flaws do not drive the series of events forward, leading logically to the climactic clash or coming together that delivers the conclusion of the story.

When we write in the first person about real events and real people, we make the same choices as the fictional author, that is, describe those details of the character that are pertinent to the story. It is nothing short of egomaniacal to imagine that our characters are faithful portraits of actual people. In our digital stories, they are not even sketches, but rather, more like cartoons or contour drawings—brief and subtle outlines that highlight their most compelling, and relevant qualities.

Some of the writers that have participated in our workshops are fixated on elaborating their characters. They fear providing too simplistic a picture of the people they are describing, or their behavior in a given context, so they expand the narrative with a multiplicity of facets in order to feel more “fair:” Personal storytellers are not judges or juries, they are witnesses. And as witnesses, we seek truth inside and around the simple lines of the sketch of their memories. We, the audience, are only capable of judging the approach they take to establishing the narrative, and whether or not their attitude and tone reflect balanced judgment or unreasonable accusation.

By letting the story dictate the degree to which we know the background of the character, we avoid cluttering some of the prose with assessments that cancel each other out. We can communicate which characteristic, for the purpose of the story, we can fill in with the broad brush of a stereotype sufficient enough for our small tale so the audience can fill in the character with the complexities of their own experiences.
Finally, A Few Words on Style

During my high school and early college days as a young journalist, I carried around a copy of *Elements of Style*, the William Strunk and E.B. White companion for all writers. I have to be frank, except for their call for economy, economy, economy, not much stuck in my sense of the rules of good style. In other words, I am the last person to teach anyone about formal issues of style. Having said that, Strunk and White might have been apoplectic at much of what I love in the styles of the writing of our students. What works, particularly as the words leave the page and are spoken by the authors, is not a case study in language usage according to conventions of grammar and syntax defended by the gatekeepers of the English—or any other—language.

What works is truth. By this, I mean that an author’s truth about how he or she conceives of a personal way of storytelling *is* their style. How does truth happen in storytelling? Here is where the metaphor of journey, or quest, serves me best. Good writing has a destination and seeks the shortest path to the destination, but no shorter. The destination is usually the punch line, the pay-off, or the point of the story. Detours should never be accidental, unconscious, or indulgent. Each word and each apparent digression is critical to the final resolution of the characters’ action. I am a traditionalist in this idea, having never fallen for what feels to me to be a experimental conceit of an “anything goes” approach to narrative.

But that is my truth. I have had the pleasure of hearing thousands of people share their stories, and each with their own style of telling. Some people like the journey along the road of their story, and the significant learning that happens along the way, rather than the arrival of a singular big lesson or a resulting moral. Other people love the wonderful mystery and elasticity of language, and what they mean by story is what I might mean by poetry. Other people find themselves hearing the sounds of words like music, and really are not concerned with the meaning of the words, per se, as much as the aural jazz of the presentation, for example, that creates a dominant tonal impression, and whose meaning is profoundly more complex than the simple “message” of the story. In that sense, I accept that when it works, it works.

The good news about those of us living at the beginning of the 21st century is that we have an awareness regarding how we *tell* our stories, and how it has much less impact than how we are *heard*. Stories do a number of things to people, but only a small part of what they do has to do with story content and our stylistic intentions. For example, when people hear a story, what is occurring in their lives at that moment that either focuses or distracts their attention? What is the context in which the story is being heard? What is the ambiance of the environment?
4 Storyboarding

A storyboard is a place to plan out a visual story in two dimensions. The first dimension is *time*: what happens first, next, and last. The second is *interaction*: how the audio—the voice-over narrative of your story and the music—interacts with the images or video. In addition, a storyboard is also a notation of where and how visual effects such as transitions, animations, or compositional organization of the screen will be used.

Storyboarding in the film world is a high art bringing to life a vision of a scene. This composition includes imagining the many choices available to a director regarding camera placement, focal point, shot duration, possible edits, and camera-based effects such as panning and zooming. Storyboard artists combine illustration skills and a sense of stage business (where actors, props and sets are placed before the window of the camera), with cinematography and cinematic theory to write the roadmap for the director and film crew to organize every part of a film production.

The art of film storyboarding has taught anyone working on a story (from mega-movies to digital stories) one important lesson: Planning on paper will save the enormous expense of time, energy and money when it comes time to produce your work. Taking the time to organize your script in the context of a storyboard tells you what visual materials you require. If this exists, from the selection of images you have in your archive, then it just tells you the order of things and makes your edit go quickly. But much more importantly, especially for novice storytellers, storyboards clarify what you do *not* need, and saves you from scanning, photographing, shooting, designing, or recording things that don't fit into a particular story.

Recipes for Disaster

Our cautionary tale concerns Rick, just an average guy, getting ready to make his first digital story:

“What a great morning,” thought Rick, stepping out his back door and going to the little studio he had cleared out of a corner in his garage. “Today, I become a filmmaker. I am going to make my first digital story this weekend. Today, I’ll assemble all the material I need. Tomorrow, I’ll edit it all together.”

Rick’s story was a tribute to his parents. Their 40th wedding anniversary was in a week, and he had a great idea about a retrospective on their lives. He had taken two large boxes of photos and a few old 8 mm films from his parent’s home earlier in the week. He was confident that if he could just sort through the stuff, the story would write itself. “I know that’s how Ken Burns does it, just gather all the sources and piece it together like a puzzle.”

He had his computer fired up. He had a scanner and digital camera handy, and the video camera set up on a tripod next to the old 8 mm projector. He was going to project the film against a sheet he had hung on the wall and then record it. “Ingenious,” he thought to himself.
The day began smoothly. Rick organized the photos into piles representing five decades of his parent’s life together. “These are great,” he thought. “I’ll scan these eight from the 1950s, and these twelve from the 1960s, but the ones from the 1970s, when I was born, there are at least thirty of these I have got to use.” And on it went. The piles grew, but no scanning yet. He broke for lunch.

Then came the film. “Old 8 mm film is really beautiful, isn’t it?” he thought. “My parents are going to love this part when I had my first little swimming pool. Wow. I’ll just transfer it all, and then make my selections tomorrow during the edit.” Despite a few glitches in the camera, he eventually got it right, and by 4 pm, the video was recorded on the camera. He thought about taking notes about which sections were on his two-hour tape, but since he was having so much fun reminiscing he never got around to it.

“I have to find the right music—old show tunes and stuff. And I need a few archival images, and I bet I can find that stuff on the Internet.” After dinner he got online, and around 11 pm his eyes grew tired and his hand had gone numb. But he had everything he needed—just all in one big folder on the computer.

Rick woke up in the middle of the night and opened his eyes. “...The part where they are looking over the Grand Canyon ... I can cut to a shot of me digging myself into the sandbox when I was three. That will be so cool. I can’t wait to start.”

The next day, he scanned his images, played with Photoshop, and he captured so much video on his computer that he ran out of hard drive space. He played with his morphing software. He did everything but start on the story. Sunday evening came and it was still a big mess. The workweek was a nightmare, so he only had a few hours to actually edit.

When the event approached on Saturday, the best thing he came up with was an extended music video, fourteen minutes long, with whole sections of images, film and titles bumping, flipping, and gyrating for reasons unknown. Several of his parents’ friends fell asleep during the showing, and at the end there was a spattering of applause. Rick attributed the reaction to the heaviness of the gravy on the chicken stroganoff that was served at the dinner.

His mother, of course, cried through the whole thing.

His father, always supportive, thanked him, and said, “Rick, that was, well, really ... interesting.”

Digital stories have an advantage over film production—you are often using available material at the core of your project as opposed to creating all-new footage. But as our story shows, the material itself can be profoundly compelling for the storyteller, particularly if it is a first visit in a long time. But without a script, and an idea of how the story is told, composing a digital story can overwhelm the best of us.

Rick’s tale is the worst-case scenario for the digital storyteller: So much wonderful content and so many cool tools to play with, but so few ideas for how things will actually come together. We have met many people that have had symptoms of these obsessions, and in our workshops, we work to try and gently bring them back down to earth. We affirm that the material might seem irresistible, but we encourage students to write a first draft and complete a bit of storyboard work prior to diving into their family’s photo archive.

Professional filmmakers use the storyboard as a critical production management tool, saving countless hours of experimentation by avoiding non-essential material.
We want to encourage our participants to reach for their highest level of organization to maximize the precious time they have to create their stories. For many of our workshop participants, life may give them only a few such opportunities to really mine the archive for the critical stories of their lives. But we want to honor all different kinds of creative processes. For some, time is not so extravagant a luxury. If you can afford to excavate your archive completely, to fully examine the creative palette of multimedia tools, and to work through a series of drafts of your project to make a highly polished piece, the rewards are worth the effort.

**Making a Storyboard**

Our reference here is from a tutorial developed by the Center for Digital Storytelling in 1999 called *MomnotMom*, and is based on a reflection by staff member Thenmozhi Soundararajan. The specific section that we refer to below consists of a title, six photographs, and a short video clip. The soundtrack is a nice piece of guitar music. We’ve laid out the storyboard on the following page.

Notice how few words of the voice-over are under each picture. Each line takes about six to ten seconds to speak. In general, three to four seconds is about the ideal length for any still image to appear on the screen. If it’s too short, then it’s hard for the viewer to recognize what’s being shown; too long, and boredom sets in. If you’re laying out your storyboard and find lines and lines of text under any one picture, rethink your script or your images.

Can the script be cut down, and can the image be left to fill-in for the missing words? If the text remains long, can more than one image illustrate the essential words? You may also want to use some effects to extend the viewer’s interest in a single still image. But for now, try to use the best effect of all: letting images speak for themselves, and using words to say the rest.
Some Ways to Make Your Storyboard

1) Get a piece of posterboard, preferably large (22” x 17”), and a packet of Post-it notes. Sort out the image material you plan to use and label each of the Post-it notes with the name and, if needed, a phrase describing the image.

2) Create five or six horizontal rows across your posterboard, leaving room for writing text below each Post-it. Fill in the text of your script in pencil, and place the appropriate images above the appropriate words. The Post-its will allow you will allow you to move things around or take them out as need be and you can erase the text if you want to move it around.

3) Instead of labeling Post-its with the name of each image, you could go to a copy place and photocopy your photos. Tape or glue your copied images to the Post-its, and lay out your storyboard. The advantage here is that, just as on the computer, you can easily move things around.

4) If you’d like to work on a smaller page, photocopy the blank storyboard template on the next page or visit storycenter.org/cookbook.html and download the .pdf file.

5) If you are familiar with desktop publishing software like QuarkXPress or Adobe’s PageMaker, or you know how to layout tables in Microsoft Word, and you know how to scan images, you can make your storyboard right on the computer.

Any of these methods will work. Do whatever is convenient and easy for you. A storyboard will speed up your work in many ways. It can show you where your voice-over should be cut before you record, and it may help you to determine if you have too many or too few images chosen before you begin scanning. Storyboarding is a valuable tool, and it can also be fun. Get others to join you in your storyboarding process and make it a collaborative project.
Chapter 4: Storyboarding

Images

Effects

Transitions

Voiceover

Soundtrack

Images

Effects

Transitions

Voiceover

Soundtrack

guitar chord progression
5 Digitizing Story Elements

Now it’s time to turn your photographs from just a set of images on paper to a moving image on the screen, edit your own home movies, capture your voice and music, and blend them together into a digital story.

First we need to get organized and think about file management: an organized filing system will make your project go much faster and make things easier to save and find. Let’s take a look at how our tutorial project *Momnotmom* was organized:

Create the same set of folders and sub-folders (Mac-speak) on your hard drive. Name the main folder or directory the name of your project (or your first and last name, for easy identification in group situations where computers are being shared.) The folders *roughimages* and *readyimages* refer to images that are the originals and images that are ready for use in a video application.

### Scanning Images

This tutorial is geared towards a flatbed scanner. With so many brands of flatbed scanners and scanning software now available, this can only be a general overview. Refer to the documentation that came with your scanner for specific instructions.

#### What Can Be Scanned?

Similar to a xerox machine, you can scan anything that will fit on top of the scanner glass. This includes photographs, drawings, letters, pages from books, album covers, fabric or clothing, even a maple leaf: typically two dimensional objects. However, scanning three-dimensional items can make for very interesting results. The process of scanning itself can be part of the creativity of the project.

Size is a limitation in flatbed scanning in that items larger than the scanning area can only be scanned in sections. With some time and a bit of practice, the parts can be woven together digitally in Photoshop. A faster approach is to take a digital photograph of a large item. If you don’t have access to a digital camera, a film camera will work and then scan in the photograph.
Flatbed Scanners

The scanner itself is simple to operate. Lay your items face down on the glass. Try to fill the entire glass area with items you want to scan to save time. Close the cover. If you have photos with drastically different lighting, it usually works best to group them together with similar photos (like doing laundry), separating lights and darks. If you are scanning a three dimensional object and cannot close the scanner lid completely, covering the lid with a dark cloth or item of clothing to shield as much light as possible from the room will result in a better scan.

The scanning controls are in the software you install when you set up your scanner. Often you will also have a plug-in that allows you to scan through software like Adobe Photoshop. Look under the File/Import menu for an option for your scanner. The features available depend on how fancy your scanner is. Most will give you an option to preview the image first before you really scan it in. Take advantage of that feature to crop out blank space around the image(s) or unneeded parts of the image. A selection or cropping tool should be available to draw a rectangular selection on the preview screen, thus marking the part of the image you want to scan. Cropping also saves disk space and time.

An important setting you’ll want to check before you scan is the dots per inch (dpi). That tells you the number of printed dots, or pixels, per inch in a photo. Dpi determines the visual quality of an image. For example, web images are typically 72 dpi to reduce file size, whereas photos for fine book printing are scanned at 600 dpi. Knowing that a higher dpi gives richer detail might tempt you to scan at a higher rate.

However, a moderate dpi of 200 in most cases will provide sufficient quality for digital video and prevent slow image-processing time in both Photoshop and your digital video editor. The only exception is if the item you are scanning is quite small, for example, a postage stamp, and you know you will be increasing the end size of the image. In this kind of situation, scan at about 300 dpi.

How To Save Scans

As you scan your images, you will be asked to name the file, choose a file format for saving it, and identify where on the computer you would like to save.

As you name your files, give them short descriptive names to make it easier to remember which is which later on, when you begin editing the images. Try to keep the names under eight characters—especially if you’ll be switching between a Mac and a PC. Keep in mind that you’ll almost always have a thumbnail of the picture too.

There are about a dozen graphic file formats. While most scanning software don’t have that many options to choose from, typically they will have Photoshop or PICT file format. Some people choose to save their graphics files in JPEG format. If disk space is at a premium, that may be a good option. However, the JPEG format will compress the file and lower the image quality. You may wish to research the recommended file format for use with whatever digital editing software you’re using.

Because you organized your story project before you started scanning, you already have a place to store your files: in your Roughimages subfolder.
Digital Images: From Your Camera or the Web

Many of us have an increasingly large archive of digital images taken with digital cameras. Most of these images are immediately ready to be used in your digital story. The resolution of course depends on your camera and whether it was set for the highest resolution.

One and two megapixel digital camera images at their highest setting can be used in a digital movie, but they may pixelate (degrade) if you are cropping, panning, or zooming on the image. Three megapixel and above images will work fine for any story.

If you decide to use stock photography or images you acquire on the web, make sure they are of a minimum resolution. The pixel dimensions of width and height should add up to at least 1000 pixels. Examples: Good = 100W x 900H, or 500W x 500H, Bad = 100W x 200H. You can find the pixel dimension in your browser by right mouse clicking the image on a PC, or holding down your mouse for a couple of sec-onds on a Mac, and then opening the image in a new window. The pixel dimension is indicated in the title at the top of your browser window.

If you’re downloading images from a site such as Google’s image search, it will tell you the pixel dimensions of the picture you want to download on the thumbnail page. Do not download the thumbnail of the picture, but the full-size picture. (Note: keep in mind that web images are NOT copyright free. The same issues regarding copyright that we discussed when talking about the element of Soundtrack, in Chapter 2, apply.)

Digitizing Video

Digital storytelling is an opportunity to repurpose existing material to tell a story. Most of us have photographs that assist us in telling the story, but some of us may also have video or even film relevant to the story. Those without video footage can zoom and pan across still photos, but even a short piece of video can add to the effect of your story. In Momnotmom, the use of a short clip from an old wedding video adds a great deal of emotional depth.

Because most of our students are beginners, however, we tend to recommend that if a still image is as effective at expressing your idea as a particular segment of video, they may wish to stick with the still image to eliminate a lot of time and worry.

If you would like to put a piece of video into your story, the approach to capturing the video onto the computer will depend on the current format of the source material and the hardware and software available to you, the amount of disk space to store it on, and the memory to work with it once you start editing.

The standard of digital video on newer computers and video cameras has greatly simplified the process of capturing material onto hard drives. More often than not, the options for connecting cables from the camera are Firewire or USB. For capturing on a PC, some hardware may be necessary, such as Firewire card. With a newer Mac running iMovie or another video editor, the connection process is fairly seamless. Be sure to investigate the specific capabilities of your editing system and equipment.
Capturing in iMovie

iMovie makes it incredibly easy to capture video. Just a) connect your camera to your Mac with a Firewire cable, b) open iMovie with your digital camera on in VCR mode, c) click on the Play button, and d) then when you get to the part you want, click on Import. iMovie will save the captured video in the Clips panel to the right of the capture window.

You can fast forward and reverse the tape using iMovie to operate your camera. We recommend capturing *handles*, which means that you begin recording a few seconds before the first part you want and a few seconds after the last part, to make sure you get everything you want.

Capturing in Premiere

Plug your camera into your PC. Most cameras have Firewire “out”, but most PCs do not have Firewire “in” port. Make sure yours does. Some new DV cameras have USB out, making it easier for people using PCs to capture video. After opening Adobe Premiere, go ahead and start up the capture window by going under File to Capture. Make sure your camera or DV player is connected and turned on.

If you are able to see your source material playing in this window, then you are ready to capture. If not, click on Edit > Preferences > Device Control, and then click Options. This brings up a pull down window that can allow to select DV Device Control and options to set the specific compatibility with your camera.

In the main Capture window, you can also set a preference for where you want your video clips saved (or logged to). We suggest you target the movies to your own project folder in a folder entitled *video*. Once you have recorded a segment of video, remembering to capture *handles* as mentioned above, you will be prompted to title each clip before saving it. Make your names of the clips descriptive to help you remember selections.

Capturing in Final Cut Pro or Final Cut Express

Final Cut Pro has a similar mechanism to Premiere, called the Capture Window. This is found under the File Menu.

Like Premiere, Final Cut allows you to view your tape and make logging notes about sections, and return to capture any section you desire. Or you can capture as you go along in the process.
Recording a Voiceover

Although the voiceover, a recording of your script, is the foundation of any digital story, performing the reading can cause some anxiety. Hearing one’s own voice being played back is strange to many people, especially those who aren’t used to hearing it recorded, not to mention telling one’s own story (especially if they haven’t told it out loud before) or hearing one’s own story. Before we launch into the technical details, go back first and reread our thoughts on why the voice is such a special and important part of the digital story.

Now we’ll show you the tools to make sure your voiceover is of good quality. You will need to plug a microphone into the computer’s mic jack to record your voice directly into the computer. Some computers come with a microphone built-in, or with a small plug in microphone. We have found these will do in a pinch, but it is much better to have a mixing board to control gain (volume in) and equalization (higher or lower range of voices). We have listed our recommendations for an audio set-up on your computer.

Special software exists for audio capture and playback. Just like a pixel image on a screen, audio is measured by the amount of bit depth that is assigned to each second of audio. The higher the bit depth (8, 16, 24), the better the audio. Audio is also calibrated by the dynamic range of information recorded, from low (11 kHz) to high (44 kHz). Most, if not all computers will allow you to capture some sort of audio signal.

We recommend that you record your voiceover at the same quality level that you record your musical soundtrack: 16-bit, 44 kHz.

Many software programs exist for capturing audio from an external sound source, like a microphone. On PC platforms, these include the built in Sound Recorder software, shareware programs like Audacity, and a number of professional level audio and video production software.

<table>
<thead>
<tr>
<th>Recommended Audio Set-up</th>
</tr>
</thead>
<tbody>
<tr>
<td>1) 4 Channel Mixer (Brands: Behringer/Mackie)</td>
</tr>
<tr>
<td>2) Condenser Microphone (Shure, AKG) 3</td>
</tr>
<tr>
<td>3) Boom Microphone Stand</td>
</tr>
<tr>
<td>4) Aspiration Guard</td>
</tr>
<tr>
<td>5) Microphone Cable</td>
</tr>
<tr>
<td>6) Stereo Phono (1/4”)</td>
</tr>
<tr>
<td>7) Stereo Mini Cable (1/8”)</td>
</tr>
</tbody>
</table>
Recording a Voiceover in a 3rd Party Software

On an Apple Computer, you can use Sound Studio (a demo version is available for free download at feltip.com), iMovie, or Final Cut Express or Pro to capture voiceovers. On a PC you can use Audacity (a demo version is available for free download at http://audacity.soundforge.net). First you need to make sure you have your Sound Input settings set to the appropriate input. You can set this by clicking on the Speaker in your System Preferences and selecting the appropriate input. If you are using a mixer and microphone to record, the setting would be Sound In.

With this done, open the software program and create a new file from the file menu. An empty timeline window will pop up. You should be able to “see” your voice in the Audio Levels monitor. Check the sound input and be sure you’re recording. If you are, you will see the colored sound level bounce back and forth in the active window.

We suggest recording your voiceover in segments. Your script will guide you in how best to break it sensibly into segments of one, two, or three sentences at a time. After you’re done with each segment, play it back to make sure the sound level coming over the computer’s speakers is clearly audible and does not break up into distortion during loud passages. We also suggest you make sure your surrounding sound environment is as quiet as possible. We almost always have people record in a private, quiet room. Make sure fluorescent lights aren’t buzzing and jewelry isn’t jangling.

Click on Record, speak a sentence or two, and click on Stop.

The sound file is represented in a waveform. While listening to the sound is a good indication of an effective level, a large waveform is a better indication that the sound levels have been set
appropriately. Your voice should measure in the upper greens to yellows of the Audio Levels monitor, but should not go into the red. Here are examples of audio files.

You can boost the sound a little in Premiere or Final Cut, but it’s bes to rerecord much-too-soft clips. Too loud audio files have the tops and bottoms of the wave clipped off. That’s what causes “clipping” or a cracking distortion in the audio. These definitely need to be rerecorded. Adjust your mixer output, get closer to or further away from the microphone, or speak a bit louder or softer until you get the right wave form.

We suggest saving each segment with a file name, containing the key word from each sentence. Before these words, add a letter from the alphabet. For example, files for momnotmoom are named “a. theres.aif”, “b.curious.aif”, “c. across.aif”, and so on. This will place each in consecutive order in the timeline track of your editing software.

These software tools will almost always record in .aif, .wav, or .mp3 format. Any of these can be imported into Premiere, iMovie or Final Cut.

**Recording a Voiceover in iMovie**

iMovie has a built in application for recording voiceovers. iMovie records them straight into your Timeline wherever the Playhead is placed. The files are stored in the media folder of your iMovie project, and you can rename them and use them in other programs as well.

**Recording a Voiceover in Final Cut**

Final Cut Pro works much the same as iMovie. You find the Voiceover tool under the Tools Menu. The record feature writes to the timeline and creates the files as part of the Final Cut render files.

Unlike in iMovie or Premiere, you need to first set an In and Out point on the Timeline that indicates where you want the voiceover to go. Click on the Timeline window, at the beginning, click on your letter i key to set the in, then move down the Timeline for a reasonable duration for the segment you want to record, and click on your letter o key to set an outpoint. From here you can record.
Capturing Musical Soundtracks

Most music used in soundtracks comes from one of four sources: a recording of an acoustic selection of music (as in a friend playing a guitar, piano, or other instrument) directly onto the computer; a recording on an analog device (tape recorder, phono-graph, or mini-disc), a CD audio recording, or a digital file (mp3, wav, aif, etc). In the first two instances, the procedure for recording is much the same as with your voiceover. For the first, you put the musician in front of the microphone and have them play. For recording from a tape player or other analog device, you connect the device either directly to the computer’s audio line in, or better still, you connect it to the mixing console that you used for your microphone. The controls in each of the programs would be the same. (Of course, you could also record audio on a video tape and capture it as with video capturing, discussed above.)

If you have your chosen music on CD, however, your task is somewhat easier. On an Apple Computer, all three of the programs work on the same concept. They use the Quicktime functionality that translates files to Mac friendly formats. In Premiere for Mac and Final Cut Pro, you simply open the CD audio track you want, and the program does the conversion. iMovie uses the iTunes program to automatically offer the list of tracks, and you can select, and then Place at Playhead, the soundtrack you want, and it will convert it and send it to your Timeline.

If you already have an MP3 collection in iTunes or use the popular sharing programs or online music purchase programs, then you can use your Mp3’s directly in any of these programs by importing the file into the program, or again with iMovie, using the iTunes Library feature.

Those of you working on a PC may not be able to copy a file from a CD directly into your soundtrack folder for your project. If this is the case, a program like iTunes for PC should allow you to import the music and convert it to a file type that your software will accept (mp3 or wav).

Make sure you do not import a song directly from a CD into your project. When you eject the CD, it may remove the song from your timeline. Instead, always remember to copy the song into your soundtrack folder, and then import it.
6 Introduction to Photoshop

Why do we use Photoshop? Even though you can complete many of our simpler tasks in another application, once you get started with this program you will find that it will allow you to do much more advanced playing around with images. The only trick is not getting drawn in so deep that you forget to stop.

We’re very happy with the recent update of Photoshop Elements. At a fraction of the cost of Photoshop it has friendlier menus and instructions for new users and is fully equipped to complete all the steps of our tutorial.

You’ve digitized the images you want to use for your project, but we need to do a few things in Photoshop to get them ready for video editing. So let’s begin!

File Browser

Even though your instinct may be to double click on an image to open it, generally speaking it’s a better habit to get used to opening Photoshop first, then open your images by through the program. That’s because when you double click directly on images that may come from a variety of sources, oftentimes the computer will open them in other applications even though we want to work with them in Photoshop.

Open Photoshop Elements. Under File, go to Browse. This opens the window called the Browser which is a handy way for you to view and sort your files. In this window you can actually drag and drop files from one folder to another, rename, and delete files. It will remain open until you close the window. We recommend keeping it open all the time to allow for easy access to your files. We want to navigate to the scans folder. You’ll see thumbnails of all the images in that folder along with specific information as you click once and highlight each file.

Notice the file kidpics is a group of five photos that need to be separated. Doubleclick on the thumbnail to open this file. For this tutorial, we’ll just work on the upper left hand photo of the mother with her newborn.
Rectangular Marquee Tool

Along the left side of your screen is the Photoshop Toolbar. To help you identify tools the name of each tool appears briefly as you hover your mouse over each icon. When you select any tool in the toolbar, the icon you clicked on turns grey, and remains the active tool until you select another.

At the top of the toolbar you have a variety of selection tools. For this task we'll use the Rectangular Marquee tool.

This tool allows us to draw out a box shaped selection. To do this, click and hold the mouse (mouse-down) in the upper left hand corner of the mom and baby photo and drag it to the lower right hand corner. Now release the mouse. Marching ants appear around the selected mom and baby photo indicating an active selection has been made. If you would like to redraw the box you can click outside of it to release it and then begin again. You can click and drag inside the box to adjust its placement on the photo.

Now that we have our selection we are ready to copy this information. As in most softwares, to copy data to the clipboard go to Edit, then Copy. This way we leave our original file intact and we can now create a new file. To do this go to File and New from Clipboard. Voila!

This is the first step with all the files you scanned in batches. Of course with images from other sources, for example images from the internet or a digital still camera, separating the images will not be necessary. However, if some images taken with a digital camera may need to be rotated so that they are the correct orientation on the computer screen. To do this go under the Image pull-down menu to Rotate and choose either Right or Left depending on the image.
Sizing Images

You can imagine that with all the different images you may be preparing that you will have a variety of shapes and sizes. Some horizontal, some vertical, some square. The next step is to get them all to be a unified size and shape. But what size? When we open our video editor later, we’ll be working with the standard digital video settings of 720 pixels wide by 480 pixels high (4:3 ratio). The reason for this is that 4:3 happens to be the ratio for most TV, video and computer screens, the places where projects are most likely to be viewed.

Oftentimes the easiest way to size an image to a 4:3 dimension is to select a 4:3 piece of the image and trim off the rest of it. This is called cropping. If we take a look at the mom and baby image that we are working with, we can see that the dimensions are basically square. In this case we wouldn’t lose vital parts of the picture if we simply trimmed off the top and bottom of the image.

To do this we will use our Crop tool which is in the second column, third tool down. By now you may have noticed that as you select tools in the toolbar you have a different set of corresponding controls appear across the top of your screen. This is called the Option Bar.

Because we already know the specific size we want to crop this image we can enter this in the Option Bar for the Crop tool settings. (Note: You may need to change from Inches to Pixels in the Units and Rulers Preferences under Photoshop Elements pull down menu). In the Width box type 720 pixels, the Height is 540 pixels, and the resolution to 150 pixels/inch.

But why did we set our height for 540 pixels if we are going to be editing in 480? We’ll get to that later when we talk about our digital video editing settings. For now go ahead and size all of your images 720 x 540.

As we did with the Rectangular Marquee tool, use your Crop tool to draw out a selection by clicking and dragging, then releasing the mouse. Notice that as you draw out the selection box no matter what you do, it only makes a 4:3 rectangle. Also notice that when you release the mouse this selection box has small squares or handles on the corners and sides of the selection. These allow you to adjust the size of the box. Once you have the box the size you want it, you can adjust the placement by clicking and dragging inside the box taking care to avoid the center point. The Escape key will release the selection of you want to do it over.
Any part of the image outside the active selection is now darkened and will be removed from the image when we crop. We can see that all we’ll lose by cropping this picture at 720x540 are some wall above the mom and the bottom of the picture which are not critical to this image, so let’s crop! Double-click inside the selected area or press the return key on your keyboard, and voila our picture is now the correct size and shape!

Enhancing Images

Sizing images is something that we do for every image before bringing them into our digital video editor. So we could be finished with this image, but since Photoshop Elements makes it so easy, let’s look at some of the image quality corrections we could make to an average snapshot.

Adjusting Brightness/Contrast in an Image

First let’s adjust the lighting a little bit to brighten things up. Similar to the dials on an old TV set you can fiddle with the brightness and contrast of an image. Photoshop offers several approaches to do this but perhaps the most direct way to get an accurate adjustment is with the Levels setting. Pull down the Enhance menu to Adjust Brightness/Contrast and over to Levels.

This window has a graph representing the lights, darks and midtones in the image. Directly beneath the graph is a line with three arrows: the one on the left adjusts shadows, the middle for midtones, the right for highlights. A very simple rule of thumb for adjusting levels is to line up the arrows with the graph. In this case the arrow on the right, for highlights, is too far to the right. By sliding it to the left so that it falls under the edge of the graph our image becomes brighter without distorting the darks or contrast of the photo.

When you are happy with the adjustment click OK. Our image is brighter but what else could we adjust?
Adjusting Color in an Image

Another common correction we can make is to adjust the color in our photographs. This particular photo that we’re working on has become a bit yellowed over time. To alter this, let’s go under Enhance, to Adjust Color, and down to Color Variations.

The current image appears twice, labeled Before and After, at the top of the variations window. Below are thumbnails of different versions with a bit more of one color or another. For more or less variation of color, you can adjust the amount with the slider in the lower left of the window.

For the purpose of our project, leave the slider in the middle and click on the thumbnail named Increase Blue. The After image now reflects your change and you can compare the two side by side. The whites of the sheets and clothing are now whiter and the overall color balance is more true to life. Once you are happy with this adjustment click on OK.

Note: You also have a Reset Image button if you’d like to experiment as you adjust.

Sharpening an Image

The computer can’t make a blurry picture clear but with the Sharpen Filter button we can help define the soft edges to make the entire image look more crisp.

Under the Filter menu go to Sharpen, and then over to Unsharp Mask. This time the window shows a single preview with a detail of the image which you can use to preview the end results. Use the Zoom button just under the image window to zoom in on the face of the baby and then drag with your mouse to center it in the window. To help define the image without distorting the quality, set the Amount between 75–125%. Notice that if you click and hold the mouse down on the image you can see a Before version of the image, and when you release the mouse it show the After version. Click OK and now we’re ready to save our work!
Saving Files

Now that we’ve sized our image and played with it to our satisfaction, we’ll do a Save As into the sizeimage folder. Go under File and pull down to Save As. Name this file with a descriptive name and then navigate to the sizeimage folder.

There are several file formats for saving files you work on in Photoshop. While most of them would work fine, we’ll stick to either Photoshop or PICT file if you will be using Final Cut Pro or Adobe Premiere to edit, and TIFF or JPEG if you are editing in iMovie.

Straightening A Crooked Image

Well, our first image worked out great, but it had a lot of things going for it that some images don’t. First of all, someone did a pretty good initial job of scanning it so that it wasn’t all slanted. Sometimes, however, you’re scanning something in a rush and don’t want to worry about how perfectly placed it is, or you think something’s straight when you scan it, but it turns out it isn’t. So let’s show you how to straighten a slanty scan using our old friend, the Crop tool.

First we need to open the image which we’ve made especially crooked, just for you. Go under File to Open and open “young” from the scans folder. No doubt about it, this scan is not straight. Your Crop tool should still be selected from the crop we made on the last image. If it’s not, select it again. Because we’re using the Crop tool to straighten the image, use the Clear button to erase the 720 width by 540 height settings in the Option Bar. Move your cursor to the upper left corner of your image window, just outside the photo, and drag diagonally down and to the right until you have a box that seems to be roughly the size of the photograph. Don’t worry about being exact because we’re going to make adjustments.
The *crop box* that we’ve just made has little squares called *handles* at each corner and in the middle of each side. Move your cursor just outside the lower corner handle and it will become a curved double arrow. If you now click and hold, and pull diagonally up and to the right, the crop box we made rotates in that direction. Continue to rotate the box until its sides are parallel to the side of the photograph.

Now we’ll pull the top, bottom and sides of our crop box in and out so that they line up with the sides of the photo. To do this, move your cursor over the middle handle on any side of the box until it turns into outward or up and down pointing double arrows. By clicking and pulling on each side, we can almost exactly fit our box to the photograph.

Once we have the edges lined up how we want them, double click inside the crop box or hit the Return key on your keyboard to activate the cropping, and a you’ll have a straightened version of your image!

---

**Resizing Images with the Crop Tool**

Now that our photo is straight and the unwanted edges are trimmed off, the next step is to resize this image to our target size of 720x540. But as you can see it’s not even close to being the 4:3 ratio that we want. With the previous image, we were able to size the image by trimming off the top and bottom of the image. However, if we were to try the same kind of crop on this picture, we’d have to cut off more than half of it! So how do we get a tall and skinny image to become short and wide without distorting it?

The answer for tall images like this one is to keep the photo whole, just as it is now, and simply increase the height and width of the overall canvas around it to our desired size of 720x540.

The resulting image will then have extra blank space around the photo. You can choose any color or content you like to fill this space and become creative in your design of the screen. However, we have found solid black is the simplest solution and works well for viewing since final projects are often shown on a black screen which causes the black borders around your photos to go unnoticed.
Before we size the canvas, we need to select our background color. At the bottom of your toolbar are two color picker boxes: Foreground and Background color. In the lower left corner of this area are tiny versions of these two boxes. Click on this icon to set default black and white for your Foreground and Background. Then in the opposite corner click the icon that switches the two colors. You now have black set for your Background color. If you would like a different background color, click on the large Background color box to open a Color Picker window and select a color.

With your background color set, the next step is to open the image window for this picture as wide as you can make it on the computer screen. It should be at least as tall as the original photo and twice as wide (see image at left). We are still using our Crop tool, so after making sure it is selected in the Toolbar, go to the Option Bar to enter in the settings we used before. We want our width to be 720 pixels, our height to be 540 pixels.

Our goal is to make the selection box for the Crop tool include the entire photograph. To do this first drag the Crop tool from the upper left hand corner of the image, diagonally across to the right edge of the photo and then release the mouse. You won’t be able to drag it further in the initial selection. Notice that you have handles appear on all four corners of the selection.

Using these handles, you can drag out the selection box to increase the size of the area you are selecting to include the entire photograph. Once it is large enough and center aligned with the photo, double-click inside the selection and voila! You now have a document that is sized correctly without losing any of the original photo.

The same process can also be used for very wide panoramic images when you don’t want to lose any part of the image. The result will be a full image with black space on the top and bottom instead of the sides.

Save this new image into the sizeimage folder. You’ve now seen how we can use the Crop tool to not only trim away unwanted parts of our photos, but also to add to our overall canvas size of any given image.
Getting Creative with Photoshop

Up to this point we’ve been mastering the basics of how to size and enhance our photos to get them ready for our digital video editor. However, Photoshop is a very powerful tool when it comes to composting and altering photographs. Let’s look at how we can collage images that suit our story.

Selecting with the Lasso Tool

To make a composite image, first we need to select part of one image that we can copy and collage onto another. Let’s open our first image by going to File and Open, and choosing fish from the scans folder. The part of this image that we want includes the mother and daughter sitting on the fish, leaving out the father and background. For this task we will need a special tool that will allow us to make a selection in any shape we want.

If we go back to our Toolbar, we’ll see the Lasso tool on the left side, second icon from the top. Select this tool and look up in the Option bar. You’ll see we have three different types of lasso tools. Hovering the mouse to reveal the names, we’re interested in using the second lasso called the Polygonal Lasso tool.

Just as you can imagine with a name like lasso, this tool allows us to encircle a part of the image in a completed selection. We do this by clicking our way around the edge of the area we want to select until we work our way back to the beginning. Each time we click the mouse, we are setting points along the selection. Between points, our mouse moves in straight lines. This process is just like a game of connect the dots.

To begin, move your cursor into the image and set your first point by clicking on the upper right edge of the fish’s tail. Just click once and release. Then without clicking down, move the mouse along the edge of the tail. Stop moving and then click once again. We’ve made our first segment of the selection. Continue in this way all around the fish, mother and daughter.

As you work, avoid double-clicking the mouse because that will complete the selection. You may notice that this tool takes some time to master. However, since this is only a practice image, don’t worry about being perfectly precise. We’ll also look at how we can adjust our selection once we’re done.

When you have completely made your way back to where you began, notice that a small circle will appear by your cursor. This indicates that you are at the beginning point. Click one last time. You should now see running ants going around fish, mother and girl. Good work!
As we mentioned, you can make adjustments to the completed selection. This is true with the other selection tools as well. With our Lasso tool still selected go back to the Option bar. To the right of the three types of lasso tools are four buttons. Hovering our mouse over each to reveal the names notice the two called Add to Selection and Subtract from Selection. If you have missed a part of the selection, for example the head of the fish, click Add to Selection and go back into the image and click your way around the head. If you have accidentally picked up more than you want, for example, the father, choose Subtract from Selection and work your way around the father.

The last step we’ll do with this selection is to soften its edge. This will help smooth any sharp corners we may have made in our selection. To do this go under the Select menu to Feather and type in 5 pixels and click OK.

Our selection is ready, but before we copy this part of the image, let’s save all that work we’ve just done to create this selection. This is not the same as saving the file, instead we will create what is called an alpha channel.

**Alpha Channels**

Beyond simply copying our selection and pasting it onto another image in Photoshop to create a collaged image, we could also combine the two files in our digital video editor. We can do this using an alpha channel—another name for a mask. Basically it’s an interesting shape that we’ve isolated from the rest of the image by creating a selection. We can then mask, or hide the remainder of the image so that only our mother, daughter and fish will appear.

This is a frequently used technique in digital storytelling because it will allow us to superimpose our mother, daughter, fish selection on top of another image and make fun edits such as add motion to them. At this point, working in Photoshop, we would like to have the option to do to this kind of editing later so we’ll prepare an alpha channel.

To create an alpha channel go to the Select menu and this time down to Save Selection. A window will open that allows us name the Selection. We can use the name *alpha1* and click OK.

For now we need to copy the selection we’ve made so that we can learn about compositing in Photoshop images. Under Edit go to Copy.

You can keep this file open for now as we go ahead and prepare the next image for our collage.
Magnifying Images with the Zoom Tool

Now we’re ready to prepare the next image we’ll use in our collage. Open the file search from your scans folder. First off, let’s make this picture the right size using the Crop tool with 720 w x 540 h settings entered in the Option bar. We don’t need the bottom part of the photo, the writing, or the borders, just the woman, the water and the sky. (See below). Make your crop box accordingly and double-click inside of it to activate the crop.

Great, now our image is cropped and we’re ready to collage. But wait, what is that spot in the sky above the woman’s head? Let’s take a closer look by zooming into that area. We’ll use our Zoom tool, represented by the magnifying glass icon in the lower right corner of the tool bar; this tool allows us to get in close on any part of our image to do fine tuned work.

Click on the Zoom tool to select it, then click on the spot in the sky. Click a second and third time. You should now be zoomed in to 200% as indicated at the top of your window next to the filename. Any time you want to zoom back out, hold down the Option key while you click the Zoom tool on your image. The plus sign in the magnifying glass will turn to a minus sign, and clicking will zoom you back out.

*Note:* Double clicking on the Zoom tool in the toolbar takes you straight to 100%. You can also zoom in and out by using only the keys on your keyboard. Hold down the Command key (Ctrl key on a PC) and press the + or – key to zoom in and out.

Altering Images with the Clone Stamp Tool

Zoomed in at 200% we can now do the detailed work necessary to remove the spot in the sky using one of the most powerful tools in our palette called the Clone Stamp tool. With a little bit of practice, you’ll see that this tool allows you to do a tremendous amount of doctoring of photos if you so choose. All we’ll do here is simply get rid of a spot, but, with the Clone Stamp tool, you can remove ex-boyfriends or girlfriends from photos, make power lines disappear above the streets, or fill a garden with beautiful flowers. In other words, you can alter reality.
Locate the Clone Stamp tool on the left side of your toolbar (second from the bottom). As you might guess from the name, this tool works by making copies, or clones, of any part of an image you determine.

In this case we’ll clone, or copy from, a clean portion of the sky. With that clean area targeted, we can use it as our source to then paint over our spot.

We’ll use our Clone Stamp tool to do both of the tasks at hand, targeting and paint-ing. For the painting task we will need to choose a brush size and shape that are appropriate for the size of the area.

With your Clone Stamp tool selected, go to your Option bar. You have a pull-down menu to select the style of brush and slider menu to select the Size. In this case, we’ll use a simple brush of about 45 pixels. If we move our cursor into the image window, we see the size of the brush. Now we’re ready to target a clean area of the photo as our source area to clone from. We want an area that is similar in color but not too close to the spot.

To target an area, move your cursor into the image. Once you have located a good area to copy from, press and hold down the Option key (Alt key on the PC) on your keyboard. Notice how a target icon appears in the center of the circle. Still holding down Option key (Alt key), click the mouse once on the clean area of the sky.

The Clone Stamp tool now knows to use this targeted area as its source when we begin to paint over the spot. Release the mouse button and Option key (Alt key). Then move your cursor, which is a circle without a target, over to the spot. Now we’re ready to start painting over the spot. Click on top of the area to begin. Voila! The spot has disappeared!

Notice that when you click, a crosshair appears back where you targeted your source area. That’s to help you keep an eye on where you are copying or cloning from. As you move around the image that crosshair will follow, so be careful when you begin using areas to copy from that you don’t want. To avoid making a mess, the best way to use the Clone Stamp tool is to set target areas often and nearby the area you are trying to alter.

Now we are ready to collage this photo with the image we prepared earlier.
Photoshop Layers

The central concept when compositing works in Photoshop is called layers. When you bring different images together into one Photoshop file, each piece you bring in creates its own layer. These layers are arranged one atop another, essentially creating a collage. The importance of this is that you can work on individual layers without affecting others. To show what we mean by layers and compositing, we want to take the search720 image we have completed and now Edit, Paste the cut-out fish from fish720 on top of the our search image. What you get is a big old fish plonked on top of the woman in the image. That doesn’t work.

Notice in your Palette Well you have a palette called Layers. Click on Layers and note that now there are two Layers, the original Background, and Layer 1 with the fish. Note that Layer 1 is grey, or highlighted, to indicate that we are working on that layer.

We can also move the image, using the Move tool. Click and drag the fish to the left to move it away from the woman’s face. When the Move tool is activated we can also reduce or expand the image by clicking on one of the four corners and dragging. Hold your Shift key down first to maintain the correct aspect ratio, find the corner, and then drag diagonally to make the image smaller as shown.

One of the adjustments we can make is to reduce the Opacity of the image. As we click on the slider as shown, you can make the image appear to fade, allowing the background to blend with the fish image.

Any layer can have any filter, or image adjustment (Variations, Levels, etc) applied to it, or a layer style as we will look at a little later. As you can see, layers allow endless flexibility in the design of your screen. So, enjoy!
Adding text with the Type Tool

Finally, we want to introduce you to the Type tool. You will also have the ability to add and manipulate text in our digital video editor. However, we'll take a look at both so you have the option of choosing either.

Select the Horizontal Type tool in the toolbar. Place the cursor anywhere in your image and click the mouse. A cursor will appear waiting for you to begin typing. Let's type the title of this piece: momnotmom.

Now let's take a look at some of the settings for our Text tool in the Option bar. Similar to a word processor, we can adjust the font, size, style, color, etc. With the text highlighted, you can change color, by clicking on the color picker. If you bring your mouse over the image, you can select a color with the Eyedropper tool from the palette of colors in the image, in our case from the shade of black in the young woman's hair. If you want to move the text to another part of the image, you can use the Move tool.

The last adjustment we will put on the image is a Drop Shadow on the text. In your Palette Wall click on the Layer Styles tab to open the Layer Styles Palette. Drag it down into the main part of your screen while you are doing the following task.

With our current text layer selected in our Layers Palette, we can now apply a drop shadow to the text simply by clicking on the icon for a Low Drop Shadow. This will add a subtle three dimensional effect to your text. You can also apply this style to the fish as well as the text.

Note: Applying a Layer Style will bring the Layer Opacity back to 100%. You can then adjust it after you have completed your Layer Styles.
Using the Undo History Palette

As you saw earlier with Layers, Photoshop has a collection of Palettes, or menus which are stored to the right of your Option bar in an area called the Palette Well. You can use this to access your Palettes as you work with them, and then neatly tuck them away when you are finished to give you more space in your work area. To close a Palette and return it to the Palette Well simply click on the button in the upper left hand corner of the window.

One of the most handy Palettes you will use in Photoshop is called the Undo History Palette. While you have been sizing, cropping, and collaging your photos, the Undo History Palette has been busy keeping a record of every step you take since opening any given file. This allows you to change your mind and go back as far as you need. By clicking on different steps in the Undo History Palette list, you can rewind and then fast forward again until you have settled on the version you want. As you can imagine this will give you tremendous flexibility in your work.

Note: Once you close the document its history is erased. You can also set the number of steps that are recorded in your Preferences. If you prefer, you can also use the Edit > Undo feature of Photoshop which will allow you to undo the very last step with an image.

Scrunching Images for Digital Video

As we mentioned in the beginning of this tutorial, in order to bring all of our images into our digital video editor in a uniform size, we needed to size each one to the specific dimensions of 720x480 pixels, our DV standard. Why then did we size them to 720x540?

Basically it has to do with the shape of our individual pixels. If we were to zoom into an image as far as we can go in any image, we’d see that it is made up of a series of small colored boxes or pixels. In Photoshop these pixels are perfectly square. In digital video, however, the standard pixels shape is more of a vertical rectangle. This causes a bit of a nuisance. Imagine that you have a photo of the full moon, round and glowing and beautiful. If you were take it into our digital video editor as is, each of those square pixels that make up the moon would stretch into the standard vertical rectangle and your moon would end up looking more like a glowing, upright egg.

So what we do before we exit Photoshop, is get our image looking just how we want it to look at the 720x540 dimension and then we scrunch it. We take that round moon and squish it down flat a little bit, like a boy sitting on a basketball that has very little air left in it. That way, when the square pixels of our scrunched moon expand into vertical rectangles, our squashed basketball moon expands into our beautiful round moon.

Luckily Photoshop Elements makes this a very easy task. Using the Batch Processing feature you can convert all of your images in a single step. When you have completed your last photo and saved them all into your sizeimage folder, open your File Browser window to view the thumbnails of the photos in that folder. Remember you can click once on each file to bring up file data. In particular we are interested in double checking that the dimensions are correctly set at 720x540. Examine each file in your sizeimage folder and make any necessary corrections before continuing.
Now we’re ready to do our scrunching. To do this, under the File menu go to Batch Processing. First we need to identify which Files to convert. We want to do our entire sizeimage folder so click on Source and navigate to sizeimage.

Next we want to Convert the Image Size for each one of the files in this folder. For Image Size we’ll set the width to 720 pixels and then because we are distorting the ratio of the original image, we uncheck the Constrain Proportions box. Now we can enter 540 for our height.

The last step is to set our Output Options for these files. Click on Destination and navigate to your main project folder. Instead of saving these in your sizeimage folder, click on the New Folder button and name the folder *scrunch* or *dvresize*. That way if you have additional photos later on you’ll be able to save them first into sizeimage and then convert them individually with the Resize Image feature and save them into this new folder. Click OK and sit back while Photoshop opens each file, resizes it from 720x540 to 720x480 and saves it into your *scrunched* folder. Now you are ready to take that folder of images into your digital video editor. Congratulations! You are officially a Center for Digital Storytelling Photoshop Pro.

Photoshop is a wonderful tool to learn, and with this tutorial we have just scratched the surface. To learn more about all the tricks and techniques in Photoshop Elements you can use the helpful Hints and Recipes Palettes as well as published manuals and design books at your local bookstore. You can also visit *adobe.com* for more information and the latest software updates.
7 Introduction to Final Cut Express

At CDS, the video editing software we use most often is Final Cut Express. This is the relatively inexpensive consumer version of a professional video editing suite. Final Cut Express gives us the capability to synchronize images and sound, add special effects, and export projects as standalone videos in a variety of formats.

In this tutorial, we will be showing you the tools necessary to create a basic digital story. Even using a small fraction of the tools available to us in Final Cut Express gives us many creative possibilities.

Momnotmom: A Digital Story

In 1999, former CDS community programs director Thenmozhi Soundararajan created "Momnotmom", a movie about her mom, to be used as the basis of our tutorial. To view the original "Momnotmom", open the Quicktime movie, momnotmom.mov, in your tutorial folder, or visit: http://storycenter.org/momquicktime.html.

As you watch the digital story, you will notice that the story is complimented by images that are synchronized to appear at specific moments of the story. When Thenmozhi imagines her mother as a young woman, the picture that appears on the screen contributes to the contemplative tone through the long slow zooming effects that have been applied. The fish that appears floating through the frame contributes a sense of otherworldliness to the story. As Thenmozhi recalls the roles her mother has played throughout her life, the images start changing much more quickly, helping the viewer transition to a more analytical mode. You are gently put on notice that Thenmozhi will lay out the facts and make the argument that will lead to a conclusion and resolution in the story.

From "Momnotmom", and other stories you have viewed, you can see that assembling a digital story is a process in which the voiceover, images and soundtrack are pulled together in a very specific way. Thenmozhi’s story has images that appear for different lengths of time. In addition to the panning and zooming and floating fish effects, you may have noticed that the transition between images is almost always soft. The images don’t change abruptly; instead they dissolve into one another. Finally, the music complements the tone without interfering with our ability to hear her voice.
Getting Started

FCE allows us to control how the image, voice and sound clips are synchronized. It will allow us to adjust the voice clips by creating longer and shorter pauses between phrases in order to fine-tune pacing. It allows us to determine the sequence in which the images appear in the digital story and the length of time each one stays on the screen. It gives us the freedom to create movement over a still image by using panning and zooming effects, or create layered effects by superimposing one image over another. Finally, it allows us to adjust and blend the volume of the different audio elements of the story. The remainder of the tutorial will guide you through a fully-explained series of steps for reconstructing the first 45 seconds of “Momnotmom”.

The first section of the tutorial will introduce the basic elements of the Final Cut Express interface: the browser, the canvas, and the timeline. After completing this section of the tutorial you will be able to import media files into your project so you can begin work on your story.

Opening Final Cut Express

To open FCE, go to the dock at the bottom of your screen and click on the FCE icon like the one on the right. It will bounce up and down for a moment and open to the following screen:

If your screen is arranged in a different manner you can go to the menu and select Window > Arrange > Standard in order to make the configuration of your screen match the one you see above.
Please see the image below for help navigating to the command for standardizing your screen.

The FCE interface is divided into three major elements. At CDS, we commonly use the metaphor of baking a cake to understand how these elements support our efforts to create a digital story. The upper left hand portion of the screen is called the Browser (1). It can be thought of as the pantry where the ingredients for baking our cake will be found. The lower portion of the screen is taken up by a Timeline (2) which can be thought of as the mixing bowl, where the ingredients will be mixed together to create the digital story. The upper right hand portion of the screen is occupied by two windows, the Viewer (3) and the Canvas (4) is like an oven with a glass door that allows you to see the cake as it cooks. The Viewer will be less important, but will also allow you to observe the ingredients that make up your cake.

**Importing Media**

The first task that must be accomplished when starting your digital story is to import the audio and image files from which the story will be assembled. These files will be easily accessible after having been organized into their respective *voiceover*, *readyimages* and *soundtrack* folders beforehand.
Import the files by going to the menu and choosing File>Import>Folder. When the window titled Choose a Folder appears, navigate to the desktop and go to the folders where the voiceover, readyimages and soundtrack are saved.

Select the voiceover folder and click Choose. The voiceover folder will appear in the Browser window, or pantry, of the Final Cut Express interface. Repeat this process with the readyimage and soundtrack folders (if you have already saved material to this folder) and the video folder if needed.

You can think of this as taking the ingredients for the cake out of the grocery bags and placing them into the pantry.

Your Browser window will look similar to the image on the right. You will see a series of buttons at the very top of the browser window on the right. If the folders appear as a list or as very large folders you may want to click on View as Medium Icons button which will change the appearance of the Browser so that it shows your folders as medium icons. To find this button, move your mouse pointer slowly over the buttons without clicking so you can see the tags that pop up with each button. The View as Medium Icons button should be either the second or third button from the left.

**The Timeline**

The Timeline is our mixing bowl. It is the key component for bringing together the sound and images that will comprise your digital story. Before placing any files onto the timeline you will notice two important features:
One is that it is divided into horizontal tracks labeled V1, V2, and A1, A2, A3 and A4. The tracks labeled V are for video and image clips. The tracks labeled A are for audio clips. The second important feature to notice immediately is the calibration along the top of the timeline. These time markers tell you the length of time your images and sound are playing. Based on this information, you will be able to manipulate your digital files and synchronize the sound files and images that will comprise your finished digital story.

![Image of timeline with video and audio tracks]

**Placing Voiceover on the Timeline**

The heart of the digital story is the voiceover you have created from the script. Since this is the most important element of the story, we will place it on the timeline first. The voiceover will drive the creation of the visual narrative once it has been put in place.

After completing this section you will be able to identify the following elements of the timeline: audio tracks, video tracks, calibrated area, playhead, waveforms, scroll bar, trim tool, zoom control.

In addition, you will be able to do the following:

- Correctly place voiceover files on the timeline
- Listen to your voiceover
- Control the playhead and use it to mark edit points
- Interpret waveforms
- Zoom in and out of the timeline depending on your editing needs
- Trim voiceover files
- Move voiceover files
- Save your digital story
- Avoid unintended changes by locking voiceover files
Placing Voiceover Files on the Timeline

First, look inside the voiceover folder by double clicking. If you are doing the CDS tutorial, three voiceover clips will appear in a new window. These three clips are organized in alphabetical order according to the naming convention used during the recording process when the first segment of the script was given a name beginning with “A”. The rest of the clips were named in alphabetical order—the second segment starts with “B”, the third with “C”, etc. Close this window by clicking on the first circular button at the upper left hand corner.

To place the voiceover files on the timeline click on your voiceover folder and carefully drag it down to track A1. Do this very slowly, and don’t lift your finger from the mouse button immediately.

There are a number of items that you must pay attention to before completing the click and drag maneuver. You will see that as you drag the folder over the A1 track, a shadow appears over A1 and A2. This happens because you have made a left and right channel recording of your voice.

You will also see an arrow that points to the right when it is positioned at the very top of the A1 track and points down when you drag it down a fraction of an inch. You can think of this arrow as your mixing spoon. You will want to develop the habit of releasing the mouse button when the arrow points **down** whenever you are placing any type of clip on the timeline. To extend the cooking metaphor, the spoon only works when it is pointing down, you can’t use it to mix ingredients properly when it is pointing to the side.

This habit is important because when you place images or new audio clips on the timeline, releasing the mouse button when the arrow is pointing to the side can cut up and move your images and audio clips in ways that you are not anticipating, setting your work back significantly.

When the shadow that’s created by the voiceover folder is approximately lined up with the third second mark in the timeline (and the arrow is pointing downward), release the mouse button. Your view of the timeline will jump from the beginning to the end of the last voiceover clip. The end of the voiceover is at approximately the forty-three second mark in the timeline.
The Playhead

For the first time you will notice another very important element of the timeline: the Playhead. It is the thin black vertical line with a yellow triangle at the top. The yellow triangle is in the calibrated area of the timeline and marks the end of your voiceover very precisely. You will use the playhead regularly as you design your digital story in order to precisely mark beginning and ending points for your image and audio clips.

Next, you will move the playhead to the beginning of the timeline. To do this, first click on the Scrollbar and drag it as far as it will go to the left. Make sure to click in the middle of the scroll bar (not the ends) and drag it all the way to the left.

Finally, use your cursor to click near the three second mark in the calibrated portion of your timeline. The playhead will appear where you clicked. If you click in any other place in the timeline, the playhead will not move.
Viewing Waveforms

At this point, it will be very helpful to be able to visualize the waveforms that represent the sounds in the audio clips that have been placed in the timeline. You will need to use the Final Cut menu bar at the top of the screen to do this. Go to Sequence > Settings. A Sequence Settings window will pop up and give you an option to click next to Show Audio Waveforms. Make sure this option is checked. While you have this window open, you may also click on Show Keyframe Overlays as well. This will be helpful later. When done, click OK. The box will close and you will see the waveforms appear in the voiceover clips.

These waveforms represent the variations in recorded sound. The sound is loudest and strongest where the waveforms are bigger and softest where the waveforms are smaller. You can see pauses in the voiceover where the waveforms straighten out into a straight line.

Zooming

At this point you may not be able to see the entire length of the voiceover on the time-line. It’s important to be able to have all the ingredients in view when mixing the cake batter, and in order to achieve this, we will need to zoom out from the timeline. As you continue your work on the digital story, you may also need to look at some of the ingredients under a magnifying glass to do some fine-tuning. In these instances, you will want to be able to zoom in. There are two methods for zooming in and out.

Method 1: Move the marker on the metered strip directly to the left of the scroll bar by clicking further to the left for zooming in and further to the right for zooming out.
Method 2: Click on either end of the scrollbar to increase or decrease its size. Zoom out by increasing the length of the scrollbar. Zoom in by decreasing the length of the scrollbar.

For example, you would click on the right tip of (the image above) and drag to the right in order to zoom out. To zoom in, click on the right tip of the scroll bar and drag to the left.

**Saving the Project**

Saving the project is simple. There are two things to keep in mind when saving your digital story. The first is to navigate to the *correct projects* folder and the second to save with the correct naming convention.

To navigate to the *correct projects* folder when you are completing the tutorial, first make sure your window looks like the image at right by clicking on the column view button. Then, click first on Desktop which appears in the left-hand column, then CDS Tutorial Mac, and then Projects. When you are working on your own project you will navigate to the project folder that is nested in the folder labeled with your name.

When naming the tutorial project, enter your first and last name in the Save As field followed by the abbreviation Tut. Then, choose Save, and save often!
Listening to the Voiceover

After spending time arranging the view of the voiceover, it is time to listen to it. To start, make sure the playhead is placed immediately to the left of the voiceover clips. As the playhead moves over the clips from left to right, you will hear the sounds represented by the waveforms. The best way to control the playhead is with the spacebar (the long, horizontal key at the bottom of the keyboard). To start the playhead, simply tap the spacebar once. To stop the playhead, tap the spacebar again. Practice starting and stopping the playhead.

Hand position is an important part of controlling the playhead efficiently. After starting the spacebar, don’t let your hand float over to the mouse. As you listen to the voiceover, you will often want to stop the playhead very quickly—in order to pinpoint a glitch in the recording that needs to be corrected, or mark a precise point where you want the sound to begin or end. Keep your hand right next to the spacebar in order to do this.

Reviewing the Voiceover

Since the voiceover is the heart of your story, a quality audio recording is the most important technical aspect of digital storytelling. It is important that the voiceover is as easily understood as possible. You will want to evaluate it for three important elements.

First, make sure that the entire script has been recorded, and that there is no section that is missing. Sometimes, a file can be misplaced or mislabeled, or for some reason does not make it into the voiceover folder. If this has happened, it is convenient to discover it sooner rather than later.

Second, you will want to pay attention to pacing. As you listen to the voiceover, make sure that the pauses between phrases sound smooth and natural. Fixing pauses that are too long or too short is relatively simple, and should be completed before placing any images on the timeline. You will find instructions for this procedure on the following page, in the “Editing the Voiceover” section.

Third, double check to make sure that there are no major errors in the recording and that all words are clearly discernible. This should be done during the recording process, but if there is still a glitch in the voiceover that makes it difficult to understand, it should be identified as soon as possible.

Helpful Tip

Saving successive files, instead of saving over the same file, is recommended (and required at CDS workshops). This is done by using the Save Project As command every time you save. The first time you save your project, add 01 to the end of your name in the Save As field. The second time you save, add 02. Eventually, you will end up with a history of your work at progressively more advanced stages of completion. If the project file you are working on ever becomes corrupt or unusable for any reason, you can always start with the last clean file you saved, rather than starting everything over.
Editing the Voiceover

As you listen to the tutorial, you will notice that the pause between the first and second segments of the voiceover is rather long and that the pacing of the story would improve by shortening the pause.

This is an operation that requires you to clearly see the waveforms that make up the pause and the words that surround the pause. You will probably want to zoom in to the pause on the timeline so that it looks like the image below.

![Timeline Image]

Put your cursor on the seam between the two audio clips. You will see the arrow turn into a vertical line with small arrows pointing left and right. This is the trim tool. Carefully, use the trim tool to click on the seam and slowly drag the edge of the first clip to the left. Continue dragging until the edge of the clip is near the end of the last waveform in the clip. Your clip should look similar to the one below.

![Trim Tool Image]

Then, click in the center of the first clip with the selection tool (your cursor should be in the shape of a normal cursor arrow, not the trim tool), and drag it to the right until it is touching the left side of the second clip. Check your clip against the one in the image on the following page.
Locking Audio Tracks

Congratulations, you’ve finished your first Final Cut Express edit! Now that we have a satisfactory voiceover, we will want to safeguard our edits. In Final Cut Express, it is relatively easy to inadvertently move and cut the audio clips in ways that can be difficult and time consuming to fix. In order to avoid these situations, it is best to lock the audio tracks when placing and editing images. Locking the tracks is relatively simple. Immediately to the right of the A1 and A2 labels you will find a button that has a picture of an open lock on it. Click on the open lock. The lock closes and diagonal lines appear on the track. Make sure to do this for both tracks. Now that you have the audio exactly the way you want it, this would be a good time to save a version of your project with a new number at the end. Remember, it’s important to save your project often, and to use the Save As command to save several successive, numbered versions of your project.

Helpful Tip

I don’t like the edit I just finished. How do I reverse it?

Press the magical combination of the Apple key and the Z key on the keyboard. Press the Apple key first, and without releasing the key, press the Z key at the same time. Release both keys at the same time. This will allow you to “step backwards.” You can repeat the Apple–Z trick multiple times if you want to go back a number of steps in your project.
Integrating Images Into Your Digital Story: Creating a Rough Edit

The visual narrative is the second component of the digital story on which we will focus. As you wrote your script, you probably thought about how your images would complement and add meaning to the voiceover. It is now time to put those in place. In this new phase of the creative process, you will also discover novel ways of interpreting your story visually—editing and revising your visual narrative as you learn how to use the various tools offered by FCE. Your rough edit will be complete when you have synchronized the entire voiceover with images. Once all your images have been placed on the timeline, you will be able to move on to the use of special effects to create movement and layers within your story.

Placing Images onto the Timeline

The process for placing images on the timeline is very similar to the one used for the audio files. Before starting, go to the RT menu at the upper left hand corner of timeline and make sure that “Low” is selected. The image on the left shows the menu that appears when the RT button is clicked. This allows FCE to playback the images more easily as you create your digital story.

The First Image

Start by going back up to your browser and double-clicking on the readyimages folder. A new window will open like the one you see below. Make sure that all the images are deselected by clicking in any area of the window that is not covered by an icon. You will not be able to see all your images at the same time, however you can use the scroll bar or arrows on the right side of the window to scroll down and see all the images in the folder.
Chapter 7: Introduction to Final Cut Express

The first step in placing an image is determining where it will go on the timeline. Since we are working with visual material, the images will go on the video tracks (those that are labeled with a "v"). At this stage, you will work only on the rough edit which takes place exclusively on the v1 track. Additional video tracks will be used to layer text and additional images onto your rough draft in the final editing stage of your story.

Next, use the playhead to mark the beginning of the word “mother” by doing the following:
- Place the playhead at the beginning of the voiceover by clicking in the calibrated area of the timeline. The playhead needle should be to the left of the voiceover as shown in the above image.
- Start playing the audio by tapping the spacebar.
- Listen to the first few words, “There’s a picture of my mother that…”
- Stop the playhead with the spacebar as soon as you hear the word mother.
- Identify the waveform that represents the word.
- Click in the calibrated space at the top of the timeline so that the vertical playhead needle is positioned immediately before the word. The image below is shown as an example.

You are now ready to place your first image into the timeline. The main difference between placing voiceover and image files on the timeline is that you will pull the image files down to the timeline one by one instead of pulling the entire folder.

In the case of this tutorial, you will want to bring the “searchTUT” image to the timeline first. Go to the readyimages folder and scroll until you see the “searchTUT” image. Click on this file and slowly drag it down to the v1 track. Do not release the mouse button yet! Before releasing the button on the mouse you need to look at two elements of your image icon: First, make sure that the black arrow is pointing down instead of to the right. This is the same procedure as when you put the voiceover files on the timeline.
Second, you will see a grayish shadow appear behind the image icon as you drag it down to the timeline. You will want to line up the left side of the shadow with the playhead before releasing the button on the mouse. Once the left side of the shadow is lined up with the playhead on v1 and the arrow is pointing down, then release the mouse button. Congratulations, you’ve just placed your first image on the timeline!

**Modifying the Length of an Image on the Timeline**

As you place the images on the timeline, you will see that their default length is five seconds. In order to time the images so that they become synchronized with the voiceover you will need to either extend them over a longer portion of the timeline or decrease their length so that they appear for a shorter period of time.

In the case of the tutorial, we will want to use the “searchTUT” image for a relatively lengthy period. To extend the image, take your cursor and place it over the right edge of the clip. You will see the arrow turn into the trim tool—a vertical line with arrows pointing to the left and right. This is the same trim tool used to edit the voiceover clips and works in the exact same way. Once the trim tool on the right edge of the clip is active, click and drag to the right. You will see the clip extend. In this case extend the clip to the beginning of the third voiceover clip as shown in the image below.

Now we have placed the clip in the vicinity of where we need it, but still have to adjust the length so that it ends precisely before the word "girl" in the voiceover. To do this, listen to the third segment, find the word girl, and position the playhead immediately to the left of the word. Remember to use the spacebar to start and stop the playhead. The playhead should be positioned as shown in the following image.
When the playhead is in the correct position, use the trim tool to grab the right edge of the clip and drag to the right until it reaches the playhead. The completed “searchTUT” edit should look like the image below. Depending on the zoom setting on your computer, you may see more or less of the clips in the timeline. Wonderful work: you have just completed your first image edit!

### Snapping

Modifying the length of the clips is also affected by whether snapping is turned on or off. The standard procedure for modifying the length of a clip (whether it’s on an audio or video track) is to use the playhead to mark the place to which the edge of the clip should extend. When snapping is turned on, as you drag the edge of the clip it will jump to the playhead as soon as it gets close enough. The edge of a clip will also jump to the edge of a different clip when dragged close enough. The snapping feature is useful in that it ensures that the edge of a clip is placed precisely at the position marked by the timeline, and that there is absolutely no space between consecutive clips. Space between clips—even a frame or two that is difficult to discern visually on the timeline—will create jerky movements when the digital story is played back. Sometimes, however, the snapping feature can interfere when the editing is being refined and you will want to turn snapping off.

---

**Method 1**

To toggle snapping on and off you can use the button in the upper right portion of your timeline. The button is shown in the image below.
Method 2
You can also go to the View menu to confirm whether snapping is on or not. The menu (on the right) shows that Snapping is on. To turn it off, use your arrow to click on the menu item.

Snapping is turned on

Placing the Final Images
You already know that the first thing Thenmozhi says about her mother’s past is that she was a girl. Click on the “girlTUT” clip in the readyimages folder and pull it down to the v1 track. Allow the left edge to just touch the right edge of the “search-TUT” image, and once the black arrow is pointing down, release the mouse button. It should look like the following image.

You can check your work by positioning the playhead before the end of the “search-TUT” image and watching the edit you just completed in the monitor labeled “Canvas.” As soon as Thenmozhi says “girl,” you should see the image in the Canvas change to the picture of the girl.

The next image that must be placed is “youngTUT.” This clip should be placed so that it appears as soon as Thenmozhi says “young woman” in the voiceover. However, the “girlTUT” clip extends over that space. In order to make room for the next clip you will have to shorten the “girlTUT” clip so that it ends immediately before the words “young woman” appear in the voiceover. Move the playhead to the beginning of the “girlTUT” clip. Tap the spacebar to play the voiceover and stop the playhead as soon as you hear “young woman.” The waveform for the words is very distinct. It allows you to click in the calibrated area so that the playhead is positioned immediately to the left of the phrase. An example of the playhead’s position is shown on following page.
After the playhead is positioned correctly, put your arrow on the right edge of “girlTUT” so that the trim tool appears. Click on the right edge and drag to the left until the clip ends at the playhead. Your timeline should look like the image below.

You can now pull the “youngTUT” image down from the readyimages folder. You may have to scroll down the window by dragging the scrollbar or clicking on the arrows on the right side of the window. Click on “youngTUT” and drag it down to the v1 track of the timeline, and position it so that the left edge is flush with the right edge of “girlTUT.”

To trim the clip follow the same procedure used with “girlTUT.” Position the playhead before the start of the clip, listen to the voiceover, determine where Thenmozhi says “a doctor,” and place the playhead immediately before the phrase. Once that position is marked, click on the right edge of the “youngTUT” clip and use the trim tool to drag to the left until the right edge is flush with the playhead. Your timeline should look like the image below.

When you are done with “youngTUT,” do the same thing with the “doctorTUT” image. Remember to trim the clip back so that there is room to insert the video clip needed to accompany Thenmozhi’s mother’s identity as a wife.
Placing Video on the Timeline

For recounting her mother’s identity as a wife, Thenmozhi had a short video clip that she took from a video of her parents’ wedding. In this case we will use just a short piece of the video.

To find the video, close the readyimages folder by clicking on the small button at the top left of the window, and double click on the video folder.

To prepare for dragging the video to the timeline, double check to make sure the audio tracks are locked. Normally, when you drag a video clip to the v1 track, the audio associated with the video clip automatically appears in the a1 track. In this case, since the a1 track is locked, FCE has no place to put the audio and will automatically delete it. Since all we want is the images of the wedding, this FCE feature works perfectly for us.

Now, click and drag the video clip all the way down to the v1 track. Position it so that the left edge is flush with the right edge of the “doctorTUT” clip. After you place it you will see a red line appear at the top of the calibrated area, and if you try to play the video a blue screen appears on the canvas that says “unrendered.”

To render the video, click in the middle of the clip so that it is selected. You will know that it is selected because the color of the clip will change to brown. Once it is selected, go to the menu bar and choose Sequence>Render All. You do not have to choose any of the options in the secondary drop down menu that appears. When the clip has finished rendering, the red line will change to a light blue line.

After the clip has been rendered we can watch it. Place the playhead at the beginning and play through the clip. For this tutorial, we will want to use only the first part of the clip, and stop the clip when the image of the smiling woman behind Thenmozhi’s mother appears. The smiling woman conveniently appears right before the voiceover goes on to the last phrase of the clip. Trim the clip using the same procedure as when you trimmed audio and image clips. Use the trim tool to click on the right edge of the video and pull back to the left so that it stops immediately before the phrase “and a mother.”

If you had wanted to trim the beginning portion of the video, the same principle would have applied. Instead of grabbing the right edge of the clip and dragging left, you grab the left edge of the clip and drag right.
Finishing the Rough Edit

At this point, there are two images remaining to be put in the timeline to finish the rough edit of the digital story. Place the last image on the timeline by opening the *readyimages* folder and clicking and dragging the “motherTUT” image into position immediately following the video. As with the other images, the left edge should just touch the right edge of the video.

Finally, you will want to place the image that will be used as the background for the title at the beginning of the story. Go to the beginning of the timeline. Make sure the playhead is placed before the voiceover begins. Click and drag the “moonTUT” image down to the timeline. Before releasing the mouse button, make sure that the right edge of “moonTUT” is lined up with the left edge of “searchTUT.” When the edges are lined up, and the black arrow points down, release the mouse button and let the image drop onto the timeline. Use the trim tool to trim the left edge so that it lines up with the beginning of the first voiceover clip.

Congratulations! You have just finished your rough edit. You can check your work against the image below by zooming out on the timeline so that all the audio and image clips are visible at the same time.

Special Effects and Background Music

You now have a basic digital story complete. However, there are a number of special effects that can be used to more effectively convey the mood and sentiment of the story. At this point you may want to revisit *Momnotmom at storycenter.org/momquicktime.html.*

Notice how the panning and zooming feature is used on the search image to focus in on the mother and to enhance the sense of conjecture as Thenmozhi thinks about her mother’s life. The fish that is superimposed over the search image gives a sense of mother and daughter journeying together. Transitions between images make going from one image to the other less abrupt and the visual narrative becomes smoother. The titles give a little context for what we are about to view, and the soundtrack adds to the tone of the digital story. At the end of this section you will be able to:

- Add transitions to your digital story
- Pan and/or zoom over images
- Superimpose images on the rough edit of your timeline
- Add a soundtrack and adjust the volume
- Add titles, or any other text, to your digital story
Panning and Zooming

Panning and zooming is used to add movement to images, focus attention on an important element of an image and to contribute to the mood of the story.

As you know, a video is made up of individual frames with still images that give the illusion of movement when viewed one right after the other. The video that we are creating for the digital story makes images appear on the screen at the rate of 30 frames per second. When we watch a still image in a video, each one of those frames are exactly the same. To zoom into an image, or pan across an image, you will need to create something called *key frames*. Essentially, this is a process in which you designate a particular frame as the place where a zoom or a pan starts and a second frame, further along the timeline, where the zoom or pan stops.

In order to recreate the panning and zooming that appears on "searchTUT" you will need to use the playhead and Canvas in the upper right hand corner of the screen. Activate the canvas’ ability to designate keyframes by clicking on the button with the square at the top of the canvas and make sure that the following three items are selected: Image + Wireframe, Show Overlays, and Show Title Safe. See the example in the image at right.

The clip starts with a tight zoom on the mother’s face and then zooms out fairly quickly so that the entire image is visible. You will place the first keyframe at the beginning of the image "searchTUT." First, place the playhead at the very beginning of the image clip, making sure you can see "searchTUT" in the canvas. Also, select "searchTUT" by clicking inside the clip on the Timeline.
Then, go to the view control at the top of the Canvas that contains a number expressed as a percentage. Click on the percentage and change it to 25%.

Next, click inside the Canvas so that two diagonal lines form a white X across the Canvas. The four corners of the box have handles that will allow you to click and drag them out so that it looks like you’re zooming in to the middle of the photo. Zoom in just enough so that the canvas frames the mother’s profile. You will also need to click inside the canvas and drag it to the left just a little to center the profile. Your canvas should look like the image at right.

Once your canvas is set, you can set the keyframe by clicking on the button that is shown above. When you click the white X, it will turn green—this indicates that the frame that is marked by your playhead in the timeline has been designated as a keyframe.

A summary of the steps for designating keyframes is shown below. Remember that it is very important to go through these steps in the order shown.

- Select the clip that will contain the keyframe by clicking on it.
- Place the playhead at the spot in which the motion starts, stops, or changes.
- Use the wireframe to set the image in the canvas to the desired position.
- Click on the Add Motion Keyframe button to set the keyframe.
To set the next keyframe in the clip make sure that the clip is selected. Start the playhead at the beginning and play the story through the end of the phrase “it’s a curious photo.” Stop the playhead immediately after the end of the word “photo.” This is where you will put the next keyframe. Go back to the wireframe and drag the handles towards the center so that the entire image is shown just within the wireframe. You should not be able to see any black borders.

Once the position on the canvas is set, click on the Add Motion Keyframe button again. You have just set your second keyframe.

The next keyframe will create a pause in the motion for about three seconds. Make sure “searchTUT” is selected. Position the playhead immediately after the phrase “I always imagine that people pose for their future.” Leave the wireframe in exactly the same position as for the second keyframe. Then, click on the Add Motion Keyframe button. Because the second and third keyframe are set to exactly the same position, the image will not move over the period of time between the two keyframes.

The final keyframe will be near the end of the clip. Select the clip. Place the playhead after the phrase, “I feel like my Mom is searching for her past.” Go to the canvas and click and drag on the handles and position the wireframe so that it contains only water, the shore and the sky, like in the example on the following page. You will probably need to go to the button that allows you to adjust the percentage of the view and set it to 12% in order to do this. Once the wireframe is positioned correctly, click on the Add Motion Keyframe button.
Superimposing Images on the Rough Edit

Another technique that is often used in digital storytelling is to superimpose one image over another. The technical term for this is *compositing*. It is one of the features usually not available in more basic programs. Using a more advanced program like FCE allows us this added dimension of creativity.

One of the fanciest aspects of the tutorial is the fish that flies across the screen holding Themnozhi and her mother. Once the image that you want to superimpose has been cut out and has been saved with an alpha channel in Photoshop Elements, it is quite simple to introduce it into the tutorial story.

Superimposing one image on another is always done by using multiple tracks. Anything that appears on the v2 track will be superimposed on v1 and images on the v3 track will overlay tracks v1 and v2. Professional video editors often use upwards of twenty or thirty tracks to create professional effects. Digital stories are almost always limited to two or three tracks.

In the case of the tutorial, you will need to make sure that your readyimages folder is open. Position your playhead immediately before the phrase “across oceans and between cultures.” Click on “fishTUT” in the readyimages folder and place it in the v2 track so that the left edge is flush with the playhead. Follow the guidelines about making sure that the arrow is pointing down as you place the image. You will see the image in track v1 split if the arrow is pointing to the side when you release the mouse button. The clip should end after five seconds, a few frames before the end of “search-TUT”. Your timeline should look like the example on the following page.
When you put the playhead over “fishTUT,” you see the fish positioned squarely over “searchTUT.” Two things need to be done in order for it to look more like the flying fish in Thenmozhi’s story. First, the whole image should occupy less space on the screen. Second, the fish needs to float over the top of the water.

Both of these special effects require the use of the wireframe. To begin, make sure the clip is selected. Then, the playhead must be positioned at the beginning of “fishTUT,” as shown below. Next, make sure the view percentage is set at 25%.

Now you are ready to shrink the fish by clicking on a wireframe handle and dragging towards the center just a little bit. Your wireframe should look like the one below.
Then click inside the wireframe and drag the entire box to the lower left until it is completely off screen. Your wireframe should look like the one on the right. You are now ready to designate the keyframe by clicking on the Add Motion Keyframe button.

To designate the second keyframe, make sure the clip is selected. Place the playhead at the end of the clip and then click and drag the wireframe box across the canvas to the right so that the fish is positioned offscreen on the right side of the canvas. Once the wireframe is positioned correctly, designate the keyframe by clicking on the Add Motion Keyframe button. Now, position the playhead at the beginning of the clip, and examine your handiwork—beautiful!

**Creating Transitions Between Images**

When used correctly, transitions will give your digital story a more polished look. They are usually used to soften the manner in which one image leads into the next. Transitions are not always needed, and it is often useful to leave them out when a more abrupt change from one image to the next punctuates specific ideas. The transition you will want to use 99% of the time is the *cross dissolve*, in which one image dissolves out as the next image dissolves into the frame. This is the transition we are most accustomed to viewing on TV and in movies, and is least disruptive to the flow of the story. A decision to use a different transition should only be made when there is a particular reason to do so. Otherwise, it is very easy to create a situation in which transitions become a distraction rather than enhancing the story.

Another important note about applying transitions is to wait until you have finished any panning, zooming or overlay effects before introducing the transitions. Panning and zooming effects always need to be applied to clips before the transition is applied. Although this is not absolutely necessary when superimposing one image over another, it is still easier to create the overlay before the clip has been encumbered by a transition.
Applying a Cross Dissolve

The first method for placing a transition between images that will be presented is the one used for placing FCE’s default transition. Since it is so commonly used, FCE provides an extremely simple process for adding the cross dissolve transition to your project. After explaining how to place a transiton in this manner, we will go to the transition menu to see the broad array of transition choices that are available.

To place a cross dissolve, click on the border between “moonTUT” and “searchTUT.” You should see a brown shadow appear over the seam between the two pictures, as shown in the image below.

![Image of cross dissolve transition in FCE](image)

This is how you know that the border is selected. If you click and do not see the border highlighted, you may want to check to make sure that the two images are actually touching each other at their edges. You can do this by zooming into the area to look at the finer detail of the border. Once the border area is highlighted, add the transition with the Apple—T keystroke combination. You do this by holding the Apple key down, and once it is depressed, tapping the T key before releasing the Apple key.

When you are done your transition will look like the one below.

![Completed cross dissolve transition in FCE](image)
The default time on FCE transitions is usually one second. Once a transition is on the timeline, it can be extended or made shorter by moving the cursor arrow over the edge of the transition and using the trim tool to click and drag the edge of transition left or right, depending on which way you need to adjust it.

The second method for placing transitions on the timeline is used for any other type of transition. Transitions can be found in the Effects tab that is contained in the Browser window. Go to the Browser window and click on the tab that says Effects. You will see a list of different types of transitions like the one in the image on the right.

Click on the small triangle immediately to the left of Video Transitions. A list of transition types will appear and you can see the individual transitions by clicking on the triangle to the left of any of the folders on the list. The dissolve folder contains the cross dissolve you’ve already seen, and another relatively common transition, the fade-in-fade-out dissolve.

To use the transitions click on the transition name as shown on the right, and drag it down to the seam between images to which it needs to be applied.

Transitions may have different properties. For example, the fade-in-fade-out transition will be applied to the end of one clip, rather than straddle the seam between two images. When you place it at the seam you will see that it wants to be applied entirely to the end of the clip on the left, or the beginning of the clip on the right. If you place it at the end of a clip it will become a fade out, if you place it at the beginning of the next it becomes a fade in. You can experiment with the other transitions if you’d like.

For the tutorial, add a transition between each of the still images, leaving the edges of the video without transitions. Your timeline should look like the one on the following page.
To delete a transition that you don't like, or would like to redo, simply click on it so that it is selected and use the Delete key on your keyboard to make it disappear.

**Adding Titles to the Digital Story**

The final visual element we need to add to this digital story is a title. Adding any kind of text to the digital story is accomplished by using the small button on the lower left corner of the Viewer window that looks like a small piece of filmstrip. Click on the button and choose the Title 3D option from the menu. The Viewer and Title menu look like the one at left.

A window with a large area at the top for entering title text will appear. If you don’t see a cursor, click in the gray area in order to enter your text. In this case, the title of Thenmozhi’s digital story is *momnotmom* as shown in the image below.

In order to change any of the font characteristics, you will need to select the text by clicking and dragging your cursor over the text. Make sure that the font type, style and size match the options in the image. Pay special attention to the font size and ensure that it is set at 36.
Then, go to the third tab on the left of the controls to make sure that the text color is correct. To change the text color, first select the text, as shown below.

![Text Color Control](image)

Then click on the Style Color button and choose the color Mercury—it’s the lightest gray color possible. Click on the Apply button in the lower left corner of the window after all the options have been adjusted correctly.

![Crayon View](image)

The title will appear in your viewer against a white background, making it very difficult to see. You should be able to see the shadow of the text entered into Title 3D window. To position it on the timeline, make sure the wireframe is turned off, then click in the middle of the Viewer window and drag down to the beginning of the timeline and place it on the v2 track. In order to better control the following adjustments to the clip, use one of the zoom tools to zoom in just a little on the title. Trim the edges of the title so that it sits directly over “moonTUT.” The timeline should look like the one below.

![Timeline View](image)
When you position the playhead over the title on the timeline, you should see it superimposed on the moon image in the Canvas. You'll also notice that the title sits squarely in the middle of the frame, and that it would look much better if it were centered under the Tamal word for mother to the right of the moon.

To reposition the title, first select the title clip on the timeline—do this by clicking on the clip so that it appears with the overlay of a brownish-gray shadow. As soon as the clip is selected in the timeline, and the playhead is positioned over the clip as shown in Image 1 below, you will see the wireframe appear over the image in the Canvas as shown in Image 2.

Click inside the wireframe and drag it so that the title appears under the Tamal script. Make sure that the title stays inside the title-safe area defined by the double lines that appear around the box. It should look like the example at the left.
The title needs one final touch before completion. If you play through the beginning of the story at this point, the title appears abruptly and leaves the screen abruptly. It would look much nicer if it were faded in and faded out. We could use the fade-in-and-fade out transitions to do this.

The other technique is to manually set the fade using the opacity lines that run across the tops of the image clips. The opacity lines can be toggled on and off with the Toggle Clip Overlays button found on the lower left side of the timeline.

If you click on the button you will see the opacity lines on the image clips appear and disappear. The button and opacity lines are shown in the image below.

Use the tool palette on the right side of your screen and choose the Pen Tool by clicking on the button at the bottom of the palette. Move the cursor so that it is positioned over the left tip of the opacity line in the Title 3D clip. You will see the arrow turn into a pen tip. Click on the end of the line to make a point. Make another point immediately to the right by clicking again with the pen. Move the pen to the right end of the line and make a point on the right side and then again a little to the left to make another point. It should look like the clip shown on the following page.

**Helpful Tip**

Different screens and projection technologies may cut off parts of the video that contains your digital story. If the edge of a picture is cut off, it will almost never interfere with the meaning of the story. However, words need to be seen in their entirety to make sense. In order to guarantee that the entire word is visible when showing the story, it’s important to make sure that it is contained within the title safe area which is defined by the double lines that appear around the canvas.
The points mark the places in which the opacity of the image will change. Move your cursor over the point at the left end until you see a + Sign appear. Then click on the point and drag it straight down to the bottom of the clip. Do the same thing with the point on the far right.

Your clip should look like the one shown at left.

Adding a Soundtrack

The last element of the story that needs to be incorporated is the soundtrack. You will go back to the audio tracks to add the background music. This is a longer audio clip that will appear on a relatively long stretch of the timeline. Zoom out so that all the images and audio clips are visible on the timeline. Also, if you can't see tracks A3 or A4, use the scrollbar on the right side of the timeline next to the audio tracks to bring them into view. The image below shows you what your timeline should look like.
You are now ready to find the soundtrack audio clip in your Browser window. Double-click on the *soundtrack* folder. Then click and drag the clip down to the A3 and A4 tracks. After dropping the clip on the audio tracks, the playhead will jump to the end of the audio clip and your timeline will look something like the one shown below.

Use the trim tool to move the end of the audio so that it is lined up with the end of the voiceover and images. Then, move to the beginning of the timeline and listen to the beginning of the story.

The guitar music is lovely, however it drowns out the voiceover—the most important part of the story. The final step in integrating the soundtrack is to adjust the volume. Note that it is good to adjust the volume a little lower than what you think sounds good in the headphones. When stories are played through speakers, the music is often a little more overbearing than what you hear when you are editing the sound.

To adjust the volume on the soundtrack it will be helpful to see tracks A1 through A4 at the same time. Use the small area on the lower left side of the timeline that looks like it contains a tiny bar graph to adjust the height of the tracks. Click on the second bar from the left to make decrease the height of all the tracks. This bar is shown in the image below.

Also, zoom in so that you can see a more detailed picture of the waveforms of the soundtrack. Your timeline should look like the one on the following page.
Make sure that the pink volume adjustment lines are visible in the timeline on your screen. If they aren’t, use the Toggle Clip Overlays button to turn them on. It is the same button as you used to toggle the opacity line on and off when you were fading the title in and out. You can see it in the image below.

The volume adjustment lines are controlled in the exact same way as the opacity lines. Click on the Pen tool at the bottom of the tool palette and create points on the volume lines at the places you want the volume to change. In this case, we want to lower the soundtrack volume immediately before the start of the voiceover. You may want to unlock the voiceover for a moment, so that you see more clearly exactly where the waveforms in the voiceover start. You may also zoom in a bit more if needed.

Mark the beginning of the voiceover by positioning the playhead at the beginning of the waveforms. Use the Pen tool to put a point on the pink volume line at the point marked by the playhead. The point can be made on either of the lines on the A3 and A4 tracks. A second point will appear the other track mirroring the first. Then, put another point a bit to the left of the first point. Your points should look like the following image.
Then take the first point that was created and drag it down. When you start dragging, you will see a small yellow box appear that shows the volume level in decibels. Let go of the mouse button when the decibal level is approximately –20 dB. Your volume lines should look similar to the ones shown below.

![Volume Level Example](image)

And... you are done! You have completed all the editing necessary for the first section of Thenmozhi’s story. This would be a good point to render your whole project (on the Menu bar, go to Sequence>Render All>Both) and save it with a new version number.

**Exporting Final Movie**

If this was your complete movie, you would be ready to export your project as a new QuickTime Movie. To do this, in the menu bar click on File>Export>QuickTime Movie. For now, it’s fine to use the default settings. Simply give your file a name and choose the location where you want it saved. After you click okay, the movie will take a few moments to export. Now it’s ready to be viewed using QuickTime Player, to be burned to a DVD, or to be compressed for viewing on the web or saving to a CD.

Congratulations! You have created a digital story in Final Cut Express! Now that you have learned the basics of video editing, get out there and make more stories of your own. Good luck and happy cooking!